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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF 
document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in 
the box.

Find Backwards starts the search from the current page and goes backwards through 
the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.
       
To find the next occurrence of the word, Do one of the following:
           
            Choose Edit > Find Again 
            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted.
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To select and copy it to the clipboard:
1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 
(Mac OS) as you drag across the width of the document. 
       
To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 
(Mac OS) as you drag the length of the document.
        
To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 
on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 
in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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1 [There was no reportable action as a result of the

2 Board of Supervisors' closed session held today.]

3

4

5

6 SUP. MOLINA: THIS MORNING WE ARE GOING TO BE LED IN OUR 

7 INVOCATION BY PASTOR JEFFREY NELSON OF BETHLEHEM LUTHERAN 

8 CHURCH IN GRENADA HILLS. OUR PLEDGE THIS MORNING WILL BE LED 

9 BY CHARLES EICHELBERGER, WHO IS A MEMBER OF POST NUMBER 7243 

10 OF THE HAWAIIAN GARDENS VETERANS OF FOREIGN WARS OF THE UNITED 

11 STATES OF AMERICA. WOULD YOU ALL PLEASE STAND? PASTOR? 

12

13 PASTOR JEFFREY NELSON: THANK YOU. LAST WEEK I HAD LUNCH AT A 

14 CHINESE RESTAURANT AND THE FORTUNE SAID, "A REAL CITIZEN IS 

15 THE FELLOW WHO GETS A PARKING TICKET AND REJOICES THAT THE 

16 SYSTEM WORKS." [LAUGHTER.] ALMOST 500 YEARS AGO, MARTIN LUTHER 

17 ENCOURAGED THE CITIZENS TO FOLLOW THE LAWS BECAUSE HE POINTED 

18 OUT THAT GOD HAS PLACED CIVIL AUTHORITIES IN THAT POSITION, 

19 AND THAT THE FOLLOWING OF THOSE LAWS IS TO FOLLOW GOD'S LAWS. 

20 HE ALSO SAID THAT THOSE IN CIVIL AUTHORITY NEED TO RECOGNIZE 

21 THAT THEY HAVE BEEN PLACED THERE BY GOD AND NEED TO SERVE BY 

22 GOD'S PURPOSE. LET US PRAY. ETERNAL GOD, WE THANK YOU FOR THE 

23 COMMITMENT OF THESE INDIVIDUALS WHO HAVE GIVEN THEIR LIVES TO 

24 SERVE YOU. WE ALSO THANK YOU FOR THE LAWS AND GUIDELINES THAT 

25 THEY GIVE US. HELP US AS CITIZENS TO DO THE THINGS THAT YOU 
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1 HAVE CALLED US TO DO, TO OBEY THE LAWS AND TO WORK WITH OUR 

2 LEADERS THAT THE GOOD OF ALL PEOPLE MIGHT OCCUR. BLESS THE 

3 PROCEEDINGS OF THIS MEETING. ALLOW THEM TO MAKE OUR COMMUNITY 

4 A BETTER PLACE AND THAT YOUR BLESSINGS MAY COME UPON ALL 

5 PEOPLE. WE ASK THIS IN YOUR HOLY NAME, AMEN. 

6

7 CHARLES EICHELBERGER: IF YOU'LL FACE THE FLAG, PLEASE, RIGHT 

8 HAND OVER YOUR HEART AND JOIN ME IN THE PLEDGE OF ALLEGIANCE 

9 TO THE FLAG. [PLEDGE OF ALLEGIANCE RECITED.] THANK YOU. 

10

11 SUP. MOLINA: MR. ANTONOVICH? 

12

13 SUP. ANTONOVICH: IT'S MY PLEASURE TO ONCE AGAIN INTRODUCE 

14 PASTOR JEFFREY NELSON, WHO IS THE PASTOR OF BETHLEHEM LUTHERAN 

15 CHURCH IN GRENADA HILLS. HE WAS ORDAINED BACK IN 1985, AND HE 

16 HAS SERVED CONGREGATIONS IN OUR STATE AND IN THE STATE OF 

17 WISCONSIN. GRADUATE OF CALIFORNIA STATE UNIVERSITY, FRESNO, 

18 AND ALSO A MASTER OF DIVINITY DEGREE FROM WARTBURG COLLEGE. 

19 PASTOR NELSON HAS SERVED AS A CHAPLAIN AT BETHESDA HOSPITAL 

20 AND PSYCHIATRIC CENTER IN DENVER, COLORADO, WORKING WITH 

21 MENTALLY ILL TEENAGERS. HE'S ALSO AUTHOR OF A BOOK "THROUGH 

22 THE NEW TESTAMENT." HE'S MARRIED AND HE HAS FOUR CHILDREN. 

23 GRENADA HILLS JUST HAD A VERY LARGE, ONCE AGAIN, ANNUAL 

24 CHRISTMAS PARADE THIS PAST SUNDAY, WHICH PEOPLE FROM THE 

25 COMMUNITY WERE ALL INVOLVED. AND WE THANK THE CHAMBER AND ALL 
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1 OF THE SERVICE ORGANIZATIONS THAT HELPED MAKE THAT A SUCCESS, 

2 AS WELL. SO WELCOME, PASTOR. [APPLAUSE.] 

3

4 SUP. MOLINA: THIS MORNING IT IS MY HONOR TO PRESENT ON BEHALF 

5 OF OUR CHAIR, SUPERVISOR DON KNABE, A CERTIFICATE OF 

6 APPRECIATION TO CHARLES EICHELBERGER, WHO LED US THIS MORNING 

7 IN OUR PLEDGE OF ALLEGIANCE. MR. EICHELBERGER IS A MEMBER OF 

8 THE HAWAIIAN GARDENS AMERICAN LEGION POST 7243. HE SERVED AS A 

9 SERGEANT WITH THE 3RD MARINE DIVISION OF THE UNITED STATES 

10 MARINE CORPS FROM 1964 TO 1972, WHICH INCLUDED A TOUR A DUTY 

11 IN VIETNAM. HIS IMPRESSIVE DECORATIONS INCLUDE TWO PURPLE 

12 HEARTS, THREE MARINE CORPS GOOD CONDUCT MEDALS, A NATIONAL 

13 DEFENSE SERVICE MEDAL WITH TWO STARS, AMONG MANY OTHERS. WE 

14 WANT TO EXTEND OUR HEARTFELT APPRECIATION FOR LEADING US IN 

15 OUR INVOCATION TODAY, I MEAN IN OUR PLEDGE OF ALLEGIANCE. WE 

16 THANK YOU SO MUCH. CONGRATULATIONS SIR. [APPLAUSE.] AT THIS 

17 TIME I'D LIKE TO ASK OUR EXECUTIVE OFFICER TO PLEASE CALL THE 

18 AGENDA. 

19

20 CLERK SACHI HAMAI: GOOD MORNING, MADAME CHAIR PRO TEM. MEMBERS 

21 OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 3, AGENDA 

22 FOR THE MEETING OF THE BOARD OF DIRECTORS OF THE SANITATION 

23 DISTRICTS, NO. 27 AND 35, ITEMS 1 THROUGH 4. 

24
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1 SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY 

2 SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, SO ORDERED. 

3

4 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE COMMUNITY 

5 DEVELOPMENT COMMISSION, ITEM 1-D. 

6

7 SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY 

8 SUPERVISOR ANTONOVICH. IF THERE'S NO OBJECTION, SO ORDERED. 

9

10 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE HOUSING 

11 AUTHORITY, ITEM 1-H. 

12

13 SUP. MOLINA: AGAIN MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY 

14 SUPERVISOR YAROSLAVSKY. IF THERE IS NO OBJECTION, SO ORDERED. 

15

16 CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE REGIONAL PARK 

17 AND OPEN SPACE DISTRICT, ITEM 1-P. 

18

19 SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY 

20 SUPERVISOR YAROSLAVSKY. IF THERE IS NO OBJECTION, SO ORDERED. 

21

22 CLERK SACHI HAMAI: BOARD OF SUPERVISORS ITEMS 1 THROUGH 5. ON 

23 ITEM NO. 1, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO 

24 HOLD THIS ITEM. AND ON ITEM NO. 4, THERE IS A REQUEST FROM A 
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1 MEMBER OF THE PUBLIC TO HOLD THIS ITEM THE REMAINING ITEMS ARE 

2 BEFORE YOU. 

3

4 SUP. MOLINA: ON THOSE ITEMS, MOVED BY SUPERVISOR MARK RIDLEY, 

5 SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, 

6 SO ORDERED. 

7

8 CLERK SACHI HAMAI: PAGE 9, CONSENT CALENDAR, ITEM 6 THROUGH 

9 35. ON ITEM NO. 6, THERE'S A REQUEST FROM A MEMBER OF THE 

10 PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 12, SUPERVISOR 

11 ANTONOVICH REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO 

12 DECEMBER 16TH, 2008. 

13

14 SUP. MOLINA: SO ORDERED. 

15

16 CLERK SACHI HAMAI: ON ITEM NO. 13, THERE'S A REQUEST FROM A 

17 MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 19, 

18 THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS 

19 ITEM. ON ITEM NO. 24, THERE'S A REQUEST FROM A MEMBER OF THE 

20 PUBLIC TO HOLD THIS ITEM. AND ON ITEM NO. 25, THERE'S A 

21 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. THE 

22 REMAINING ITEMS ARE BEFORE YOU. 

23
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1 SUP. MOLINA: ON THOSE ITEMS, MOVED BY SUPERVISOR ANTONOVICH. 

2 SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, 

3 SO ORDERED. 

4

5 CLERK SACHI HAMAI: WE'RE NOW ON PAGE 21, ORDINANCES FOR 

6 INTRODUCTION. ITEMS 36 AND 37. ON ITEM 36, I'LL READ THE SHORT 

7 TITLE IN FOR THE RECORD. THIS IS AN ORDINANCE AMENDING TITLE 5 

8 - PERSONNEL OF THE LOS ANGELES COUNTY CODE RELATING TO FRINGE 

9 BENEFITS. 

10

11 SUP. MOLINA: MOVED BY SUPERVISOR YAROSLAVSKY. SECONDED BY 

12 SUPERVISOR ANTONOVICH. IF THERE IS NO OBJECTION, SO ORDERED. 

13

14 CLERK SACHI HAMAI: ON ITEM NO. 37, SUPERVISOR ANTONOVICH 

15 REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO DECEMBER 

16 16TH, 2008. 

17

18 SUP. MOLINA: SO ORDERED. 

19

20 CLERK SACHI HAMAI: DISCUSSION ITEM. ITEM 38, AS INDICATED ON 

21 THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS 

22 THAT THIS ITEM BE REFERRED BACK TO HIS OFFICE. 

23

24 SUP. MOLINA: SO ORDERED. 

25
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1 CLERK SACHI HAMAI: MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH 

2 WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS 

3 INDICATED ON THE SUPPLEMENTAL AGENDA. ON ITEM NO. 39-A, 

4 SUPERVISOR YAROSLAVSKY REQUESTS THAT THIS ITEM BE HELD. ON 

5 ITEM 39-B IS BEFORE YOU. 

6

7 SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY 

8 SUPERVISOR RIDLEY-THOMAS. 

9

10 CLERK SACHI HAMAI: 39-C. 

11

12 SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY 

13 SUPERVISOR YAROSLAVSKY. 

14

15 CLERK SACHI HAMAI: 39-D. 

16

17 SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY 

18 SUPERVISOR RIDLEY-THOMAS. 

19

20 CLERK SACHI HAMAI: 39-E. 

21

22 SUP. MOLINA: MOVED BY SUPERVISOR ANTONOVICH. SECONDED BY 

23 SUPERVISOR YAROSLAVSKY. 

24
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1 CLERK SACHI HAMAI: ON 39-F, THE SHERIFF REQUESTS THAT THIS 

2 ITEM BE CONTINUED ONE WEEK TO DECEMBER 16TH, 2008. 

3

4 SUP. MOLINA: SO ORDERED ON THOSE ITEMS AS WELL AS A 

5 CONTINUANCE. 

6

7 SUP. YAROSLAVSKY: MADAME CHAIR. ON ITEM 39-A, ALL I WANTED, 

8 THE REASON I WAS HOLDING IT WAS TO ASK -- 

9

10 SUP. MOLINA: 39-A? 

11

12 SUP. YAROSLAVSKY: YEAH, WHICH I HELD. I JUST WANT TO ASK THAT 

13 BEFORE THE LEGISLATION THAT IS BEING RECOMMENDED BE DRAFTED, 

14 IT BE BROUGHT BACK TO THE BOARD BEFORE IT'S APPROVED. THAT'S 

15 ALL. I JUST WANT TO SEE WHAT THE LEGISLATION IS. I DON'T NEED 

16 TO DISCUSS IT TODAY. AND BROUGHT BACK TO THE BOARD. THAT'S 

17 FINE. 

18

19 SUP. MOLINA: ALL RIGHT. WITH THAT UNDERSTANDING, OR THAT SMALL 

20 AMENDMENT, THAT ITEM IS MOVED BY SUPERVISOR ANTONOVICH. 

21 SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S NO OBJECTION, 

22 SO ORDERED. 

23
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1 CLERK SACHI HAMAI: AND THAT COMPLETES THE READING. AGENDA. 

2 BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH SUPERVISORIAL 

3 DISTRICT NO. 5. 

4

5 SUP. MOLINA: ALL RIGHT. SUPERVISOR ANTONOVICH, IF YOU WOULD 

6 PERMIT ME, WE'D LIKE TO MAKE ONE PRESENTATION BEFORE WE GET 

7 STARTED? IF YOU'LL PERMIT ME? 

8

9 SUP. ANTONOVICH: GO AHEAD. VERY SHORT. 

10

11 SUP. MOLINA: OKAY. THANK YOU, SIR. I'M GOING TO ASK -- HE WAS 

12 HERE A MINUTE AGO. WE HAVE A VISITOR FROM THE STATE TODAY. MR. 

13 MAXWELL JOLLY IS JOINING US. TO ACKNOWLEDGE THE EXEMPLARY 

14 CONTRIBUTIONS OF OF CHILD SUPPORT SERVICES DEPARTMENT. I'M 

15 GOING TO ASK MR. GOLIGHTLY IF HE'LL COME UP AND -- THERE THEY 

16 ARE. OVER THERE. ASK THEM TO JOIN US. FOR SEVERAL YEARS, THE 

17 STATE OF CALIFORNIA HAS BEEN PAYING IN EXCESS OF $200 MILLION 

18 YEARLY IN PENALTIES TO THE FEDERAL GOVERNMENT DUE TO THE 

19 ABSENCE OF A STATEWIDE CHILD SUPPORT AUTOMATED SYSTEM. 

20 DEVELOPMENT OF THE NEW SYSTEM, THE CALIFORNIA CHILD SUPPORT 

21 AUTOMATED SYSTEM, KNOWN AS C.S.A.S., BEGAN IN THE YEAR 2000 

22 AND CULMINATED WITH THE FINAL CERTIFICATION BY FEDERAL 

23 OFFICIALS THIS IS PAST MONTH. OUR DEPARTMENT WAS THE FINAL 

24 COUNTY GO LIVE WITH THIS NEW SYSTEM, WHICH AGAIN STARTED ON 

25 NOVEMBER THE 12TH OF THIS YEAR. OUR CONVERSION HAS BEEN 
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1 SEAMLESS AND TRANSPARENT TO ALL OF OUR CUSTOMERS. WE'RE NOW 

2 ABLE TO ACCESS SUPPORT INFORMATION FROM ALL 58 COUNTIES UNDER 

3 OUR NEW SYSTEM. AND I WANT TO THANK ALL OF OUR DEPARTMENTAL 

4 PEOPLE WHO WERE INSTRUMENTAL IN MAKING THIS HAPPEN AND IN 

5 PARTICULAR TO THANK MR. JOLLY AND ALL OF HIS EFFORTS TO MAKE 

6 IT ALL HAPPEN. WE KNOW IT'S VERY SIGNIFICANT, VERY MEANINGFUL 

7 TO ALL THE FAMILIES OF CALIFORNIA. CONGRATULATIONS AND THANK 

8 YOU AND WELCOME. 

9

10 MAXWELL JOLLY: THANK YOU VERY MUCH. [APPLAUSE.] 

11

12 MAXWELL JOLLY: GOOD MORNING, CHAIRMAN MOLINA AND MEMBERS. I'M 

13 VERY PLEASED TO BE HERE TODAY. AS YOU KNOW, THE CALIFORNIA 

14 CHILD SUPPORT PROGRAM MAKES A VITAL DIFFERENCE IN THE LIVES OF 

15 THE 2 MILLION CHILDREN THAT WE SERVE THROUGHOUT THE STATE. FOR 

16 MANY OF THESE CHILDREN, OUR EFFORTS MEAN A STABLE HOME AND 

17 ECONOMIC SECURITY. WE ACCOMPLISHED THIS IMPORTANT JOB THROUGH 

18 A STATE AND LOCAL PARTNERSHIP WHERE THE DEPARTMENT AND EACH OF 

19 THE 52 LOCAL CHILD SUPPORT AGENCIES WORK HAND-IN-HAND TO 

20 SUPPORT THESE FAMILIES. OUR PROGRAM CAN ONLY BE AS GOOD AS THE 

21 GOOD WORK OF THE 8,000 CHILD SUPPORT WORKERS OUT IN THE LOCAL 

22 CHILD SUPPORT AGENCIES, WHICH INCLUDES THE L.A. COUNTY 

23 DEPARTMENT OF CHILD SUPPORT SERVICES. AS YOU WERE AWARE IN THE 

24 PAST, WE'VE HAD CONCERNS ABOUT THE PERFORMANCE HERE IN LOS 

25 ANGELES COUNTY. AND WE ESTABLISHED CORRECTIVE ACTION STATUS IN 
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1 LOS ANGELES COUNTY TO ENCOURAGE IMPROVEMENTS IN PERFORMANCE. 

2 I'M HERE BEFORE YOU TODAY TO HIGHLIGHT THE GREAT WORK THAT HAS 

3 BEEN DONE BY YOUR DEPARTMENT IN IMPROVING THE PERFORMANCE IN 

4 CHILD SUPPORT. I WANTED TO PERSONALLY RECOGNIZE THE SUCCESSFUL 

5 EFFORT OF THE AGENCY THROUGH THE LEADERSHIP PROVIDED HERE BY 

6 THE BOARD AND BY DIRECTOR GOLIGHTLY TO IMPROVE THE CHILD 

7 SUPPORT PROGRAM. THROUGH THE BOARD  SUPPORT, THE L.A. DIRECTOR 

8 HAS ACHIEVED SIGNIFICANT IMPROVEMENTS IN COLLECTIONS IN CHILD 

9 SUPPORT. WHEN L.A. COUNTY WAS PLACED IN CORRECTIVE ACTION IN 

10 2003, OUR CURRENT SUPPORT STATISTIC WAS ONLY 37 PERCENT. THE 

11 RECENT FISCAL YEAR CLOSED OUT WITH A 48 PERCENT MARK. AND IN 

12 THE BEGINNING MONTH OF THE NEXT FISCAL YEAR, THE IMPROVEMENT 

13 WAS EVEN HIGHER. L.A. CHILD SUPPORT IS FULLY COMMITTED TO 

14 IMPROVING PERFORMANCE. AND IT'S OF SPECIAL SIGNIFICANCE IS THE 

15 FACT THAT THIS PERFORMANCE IMPROVEMENT HAS HAPPENED AT THE 

16 SAME TIME THAT THE COUNTY'S ENGAGED IN NEARLY A YEAR AND A 

17 HALF EFFORT TO CONVERT TO THE C.S.A.S. SYSTEM. IT'S BEEN A 

18 TREMENDOUSLY COMPLEX UNDERTAKING. L.A. IS THE LARGEST COUNTY. 

19 IT WAS THE FINAL COUNTY TO CONVERT. AND EVEN THOUGH A LOT OF 

20 STAFF TIME HAS BEEN DIVERTED TO THE CONVERSION ACTIVITIES, 

21 PERFORMANCE HAS CONTINUED TO IMPROVE. IT'S A TRIBUTE TO THE 

22 COMMITMENT OF STEVEN AND HIS TEAM. I'M HAPPY TO LET YOU KNOW 

23 THAT THE L.A. CONVERSION SET THE STAGE FOR THE ANNOUNCEMENT BY 

24 THE FEDERAL COMMISSIONER OF CHILD SUPPORT FOR OUR AUTOMATED 

25 SYSTEM TO RECEIVE FULL FEDERAL APPROVAL. SANCTIONS ARE LIFTED. 
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1 OUR WAIVER CAP IS LIFTED. AND WE'VE FINALLY MADE IT TO THE END 

2 OF THE LONG JOURNEY TO ESTABLISH A SINGLE STATEWIDE SYSTEM. 

3 AND I WANT TO CONGRATULATE L.A. COUNTY. [APPLAUSE.] AT THE 

4 SAME TIME, WE HAVE DONE AN EXHAUSTIVE REVIEW OF THE CURRENT 

5 LEVEL OF PERFORMANCE IN THE COUNTY, AND I'D LIKE TO LET YOU 

6 KNOW THAT BASED UPON THE PROGRESS IN MEETING PERFORMANCE 

7 GOALS, THEIR ONGOING COMMITMENT TO CUSTOMER SERVICE AND STEADY 

8 IMPROVEMENT, THE SUCCESSFUL CONVERSION, I AM TODAY PRESENTING 

9 STEVEN A LETTER WHERE I'M INFORMING HIM THAT I AM RELEASING 

10 THE COUNTY FROM CORRECTIVE ACTION. [APPLAUSE.] I WANT TO 

11 CONGRATULATE STEVEN AND HIS STAFF FOR THE EXCELLENT JOB THAT 

12 THEY'VE DONE. AND I'M ALSO CONFIDENT THAT THIS IS A FOUNDATION 

13 FOR CONTINUOUS IMPROVEMENT OVER THE YEARS TO COME. SO THANK 

14 YOU, SUPERVISOR MOLINA. [APPLAUSE.] 

15

16 STEVEN GOLIGHTLY: THANK YOU, DAVID. I'D LIKE TO THANK DAVID 

17 AND HIS COLLEAGUES FOR COMING DOWN TODAY AND MAKING THE 

18 PRESENTATION, THE SURPRISE PRESENTATION ON REMOVING US FROM 

19 CORRECTIVE ACTION AND ALSO THE ACKNOWLEDGMENT OF THE GREAT 

20 WORK THAT'S GONE ON WITH CONVERSION. BUT I'D BE REMISS IF I 

21 DIDN'T ALSO ACKNOWLEDGE THE GREAT SUPPORT THAT WE'VE RECEIVED 

22 FROM THE BOARD OF SUPERVISORS AND THEIR DEPUTIES AND STAFF AND 

23 THE COURTS THE LAST SEVERAL YEARS TO HELP US MOVE IN THIS 

24 DIRECTION. THE SUPPORT THAT WE'VE RECEIVED FROM DAVID, OF 

25 COURSE, AND HIS STAFF IN SACRAMENTO. AND FOR MY WONDERFUL 
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1 COLLEAGUES, MY SENIOR MANAGERS ARE HERE WITH US TODAY AND OUR 

2 OTHER 1,800 STAFF WHO ARE BACK IN THE OFFICE. WOULD MY SENIOR 

3 MANAGERS PLEASE STAND? BECAUSE YOU ARE SO RESPONSIBLE FOR 

4 WHAT'S HAPPENING TODAY. [APPLAUSE.] I'D LIKE TO POINT OUT THAT 

5 I'M VERY PROUD TO BE THE LEADER OF THIS DEPARTMENT, BUT I'M 

6 PARTICULARLY PROUD TODAY AS WE STAND HERE TO SAY AND 

7 ACKNOWLEDGE THAT WE'VE COME A LONG WAY FROM BEING ON THE FRONT 

8 PAGE OF THE L.A. TIMES IN THE LATE '90S TO WHERE WE ARE TODAY 

9 WITH AN ACKNOWLEDGMENT FROM OUR STATE LEADERS THAT, IN FACT, 

10 PERFORMANCE HAS IMPROVED AS MUCH AS IT HAS IN L.A. AND I CAN 

11 SAY ON BEHALF OF EVERY ONE OF MY COLLEAGUES: OUR FOCUS EVERY 

12 DAY IS ON HELPING THE MOTHERS AND FATHERS WHO COME INTO OUR 

13 OFFICE FOR ASSISTANCE. BECAUSE THE BOTTOM LINE, AND WE NEVER 

14 FORGET IT, IS THAT WE'RE HERE BECAUSE OF THE CHILDREN. SO 

15 THANK YOU ALL VERY MUCH FOR YOUR SUPPORT. [APPLAUSE.] 

16

17 SUP. MOLINA: WE WANT TO TAKE A PHOTO HERE. 

18

19 SUP. MOLINA: SUPERVISOR ANTONOVICH FOR YOUR PRESENTATIONS. 

20

21 SUP. ANTONOVICH: WELL, RIGHT NOW WE WANT TO RECOGNIZE AN 

22 INDIVIDUAL FROM THE COUNTY OF LOS ANGELES WHO HAS DONE A 

23 WONDERFUL JOB SINCE BEING APPOINTED AS THE CHIEF OF OUR 

24 COUNTY'S POLICE DEPARTMENT. IN NOVEMBER 2003, PEGGY YORK WAS 

25 SWORN IN AS THE LOS ANGELES COUNTY POLICE CHIEF. SHE COMMANDS 
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1 THE FOURTH LARGEST SPECIALIZED LAW ENFORCEMENT AGENCY IN THE 

2 COUNTY AND ONE OF THE LARGEST IN THE STATE OF CALIFORNIA. AND 

3 SHE'S WITH US HERE WITH HER HUSBAND, JUDGE, THE HONORABLE 

4 LANCE ITO, WHO IS ALSO MY SISTER'S CLASSMATE FROM THE 

5 WONDERFUL JOHN MARSHALL HIGH SCHOOL. AND THEY RESIDE IN THE 

6 FIFTH DISTRICT IN BEAUTIFUL PASADENA. THE COUNTY POLICE 

7 EMPLOYS 579 SWORN OFFICERS, 140 CIVILIANS AND CONTRACTS WITH 

8 PRIVATE, SECURITY GUARDS FOR 750 SECURITY OFFICERS. AS THE 

9 LEADER OF THE COUNTY'S LARGEST SPECIALIZED LAW ENFORCEMENT 

10 AGENCY, SHE'S BEEN DEDICATED TO THE HIGHEST IDEALS OF 

11 PROFESSIONAL POLICE SERVICE AND SHE WANTS OUR COUNTY'S POLICE 

12 TO BE THE NATION'S BEST SPECIALIZED POLICE AGENCY. SHE HAS 

13 PLACED EMPHASIS ON SELECTION, TRAINING, RETENTION OF THE VERY 

14 BEST AND ACCOUNTABILITY FOR THE QUALITY OF SERVICE PROVIDED BY 

15 OUR MEMBERS AT EACH LEVEL OF HER ORGANIZATION. CHIEF YORK 

16 STRONGLY BELIEVES THAT ALL PEOPLE SHOULD USE OR WORK WITHIN 

17 ANY COUNTY FACILITY SHOULD FEEL SAFE AND SECURE WITHIN THEIR 

18 ENVIRONMENT AND SHE PROUDLY SUPPORTS THE MOTTO DEDICATED TO 

19 THE COMMUNITY WHICH SAYS, AS DO THE MEN AND WOMEN OF THE LOS 

20 ANGELES COUNTY POLICE SERVICE. CHIEF YORK BEGAN HER LAW 

21 ENFORCEMENT CAREER WITH THE LOS ANGELES POLICE DEPARTMENT. SHE 

22 GRADUATED FROM THE POLICE ACADEMY IN 1968 AND WORKED IN 

23 VARIOUS ASSIGNMENTS THROUGHOUT HER TENURE AS A POLICE OFFICER 

24 FOR LOS ANGELES CITY. SHE WAS PROMOTED THROUGH THE RANKS AND 

25 BECAME THE FIRST WOMAN IN THE HISTORY OF THE LOS ANGELES 
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1 POLICE DEPARTMENT TO BE APPOINTED RANK OF DEPUTY CHIEF. AS 

2 DEPUTY CHIEF, SHE WAS RESPONSIBLE FOR THE POLICE STATIONS IN 

3 RAMPART, CENTRAL, NEWTON, HOLLENBECK, AND NORTHEAST. AND 

4 DURING HER 35 YEARS OF SERVICE, SHE'S WORKED NEARLY EVERY 

5 ASSIGNMENT AND IN ALL FOUR GEOGRAPHICAL BUREAUS OF THE CITY. 

6 AND SHE RETIRED FROM THE POLICE DEPARTMENT IN 2002. SHE'S BEEN 

7 ACTIVELY INVOLVED IN COMMUNITY AFFAIRS, SERVING AS THE VICE 

8 CHAIR OF THE METROPOLITAN BOARD OF THE SALVATION ARMY AND 

9 FOUNDING MEMBER OF THE ARMY OF ANGELS. A MEMBER OF THE BOARD 

10 OF DIRECTORS FOR BOOTH MEMORIAL HIGH SCHOOL IN LINCOLN 

11 HEIGHTS. AND ALSO A FOUNDING MEMBER OF THE VICE CHAIR OF THE 

12 LOS ANGELES HISTORICAL SOCIETY. SHE'S A DIRECTOR WITH L.A. 

13 FIVE ROTARY CLUB AND A PAUL HARRIS FELLOW. AND THE PAUL HARRIS 

14 FELLOW IS THAT ORGANIZATION OF PRIVATE PEOPLE FROM THE 

15 ROTARIANS WHO DONATED MONEY TO HELP ERADICATE POLIO THROUGHOUT 

16 THE WORLD. SHE'S ALSO A MEMBER AND SUPPORTER OF THE Y.W.C.A. 

17 IN GREATER LOS ANGELES AND A TRUSTEE. HER MASTER'S DEGREE IS 

18 IN PUBLIC ADMINISTRATION FROM U.S.C., AND HER BACHELOR'S 

19 DEGREE IS IN MANAGEMENT FROM THE UNIVERSITY OF REDLANDS. SHE 

20 IS ALSO A GRADUATE OF THE F.B.I. NATIONAL ACADEMY AND THE 

21 SOUTHERN CALIFORNIA LEADERSHIP NETWORK. SHE'S INVOLVED IN MANY 

22 OTHER ORGANIZATIONS. IN HER SPARE TIME, SHE ENJOYS GARDENING, 

23 FISHING, HER DOGS AND SPENDING QUALITY TIME WITH HER 

24 GRANDCHILDREN. AND WE KNOW THAT THERE'S A BRIGHT FUTURE AHEAD 

25 BECAUSE MANY OF US FEEL SHE WOULD BE A GREAT CITY COUNCIL 
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1 MEMBER FOR THE CITY OF PASADENA IN THE UP AND COMING ELECTION 

2 IN 2009. SO, PEGGY, WE WANT TO GIVE YOU THIS PROCLAMATION. AND 

3 WE APPRECIATE YOUR LEADERSHIP AT THE BOARD DURING THESE YEARS. 

4 AND I KNOW THE MEN AND WOMEN IN YOUR DEPARTMENT ALSO 

5 APPRECIATE YOUR LEADERSHIP. 

6

7 PEGGY YORK: THANK YOU. [APPLAUSE.] SUPERVISOR ANTONOVICH AND 

8 ALL OF THE MEMBERS OF THE BOARD OF SUPERVISORS, THANK YOU 

9 VERY, VERY MUCH, HONORING ME THIS WAY TODAY. I REALLY 

10 APPRECIATE IT. I WOULD LIKE TO ACKNOWLEDGE THE MEN AND WOMEN 

11 OF THE LOS ANGELES COUNTY POLICE. THEY DO SUCH A FANTASTIC 

12 JOB, SOMETIMES WITH GREAT CHALLENGES, TO PROVIDE PROTECTION 

13 FOR OUR CLIENT DEPARTMENTS WHO SEEK COUNTY SERVICES AND THE 

14 COUNTY HOSPITALS AND THE COUNTY PARKS. AND I'M VERY, VERY 

15 PROUD OF THEM. AND PARTICULARLY, I'M PROUD OF THEIR VERY 

16 STRONG COMMITMENT TO PUBLIC SERVICE AND TO COMMUNITY SERVICE 

17 AND KEEPING OUR FACILITIES SAFE. I COULD NOT HAVE BEEN AT ALL 

18 SUCCESSFUL IN MY ROLE AS CHIEF WITHOUT THE SUPPORT OF MY 

19 WONDERFUL COMMAND STAFF. AND THEY'RE ALL HERE TODAY IN 

20 UNIFORM. AND DON'T THEY LOOK GOOD? AND THEY HAVE BEEN A 

21 TREMENDOUS HELP AND SUPPORT TO ME. AND I APPRECIATE THEM SO 

22 MUCH. I'D ALSO LIKE TO THANK YOU FOR YOUR STAFF, YOUR DEPUTY 

23 SUPPORT. IT'S JUST BEEN PHENOMENAL. WE HAVE ESTABLISHED 

24 WONDERFUL RELATIONSHIPS AND COMMUNICATIONS. AND YOU HAVE JUST 

25 THE BEST STAFFS IN THE WORLD. AND IT'S BEEN A PLEASURE FOR ME 
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1 TO WORK WITH THEM. AND MOST IMPORTANTLY, I WOULD LIKE TO THANK 

2 YOU FOR YOUR LEADERSHIP, FOR YOUR PROBLEM SOLVING. I HAVE 

3 LEARNED SO MUCH IN THIS JOB. HOPEFULLY TO MAKE MYSELF A BETTER 

4 PUBLIC SERVANT. THIS IS A PHENOMENAL COUNTY. AND THE 

5 LEADERSHIP THAT YOU DISPLAY EVERY DAY IN SERVING THE NEEDS OF 

6 YOUR CONSTITUENTS IS JUST FANTASTIC. AND I APPRECIATE THE 

7 OPPORTUNITY. LAST BUT CERTAINLY NOT LEAST, MY HUSBAND, WHO 

8 ALWAYS SUPPORTS EVERYTHING I DO, WHICH IS GREAT TRAIT FOR A 

9 HUSBAND. [LAUGHTER.] SO THANK YOU VERY MUCH. I APPRECIATE IT. 

10 [APPLAUSE.] 

11

12 SUP. ANTONOVICH: ONCE AGAIN IT'S AN OPPORTUNITY TODAY TO 

13 RECOGNIZE SOME OF OUR YOUNG PEOPLE WHO HAVE DONE EXTREMELY 

14 WELL IN THEIR ACADEMIC STUDIES, AND WE WANT TO RECOGNIZE THEM. 

15 WITH ME TODAY IS TRISH PLOEHN WHO IS DIRECTOR OF THE 

16 DEPARTMENT OF CHILDREN AND FAMILY SERVICES, ARMOND MONTEL, 

17 MICHAEL RICE, ARLENE INOCENTE, AND SYLVIA FOGLEMAN FROM 

18 UBOARD, WHO IS ALSO GOING TO BE PRESENTING A $50 GIFT 

19 CERTIFICATE FROM BARNES & NOBLE. WITHOUT THE ASSISTANCE OF 

20 CARING ADULTS, AND OPPORTUNITIES FOR OUR YOUNG PEOPLE, THEY 

21 WOULDN'T BE ABLE TO MAKE THE ACHIEVEMENTS THAT THEY HAVE. AND 

22 SO TODAY WE WANT TO RECOGNIZE THE FOLLOWING. FIRST IS DAVID 

23 SOLIS, BEST ACADEMIC ACHIEVEMENT ENRICHMENT PLUS PROGRAM. SO 

24 DAVID? [APPLAUSE.] JOSE ALVARADO FOR MOST IMPROVED ACADEMIC 

25 ACHIEVEMENT. [APPLAUSE.] JORDAN HOWARD FOR MOST IMPROVED 
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1 ACADEMIC ACHIEVEMENT. [APPLAUSE.] JEANETTE RIOS FOR MOST 

2 IMPROVED ACADEMIC ACHIEVEMENT. [APPLAUSE.] SHERMONTE WHEELER 

3 FOR BEST ACADEMIC ACHIEVEMENT. [APPLAUSE.] DO YOU WANT TO SAY 

4 A FEW WORDS? 

5

6 SYLVIA FOGLEMAN: YOUTH OPPORTUNITIES UNITED IS PROUD TO 

7 PRESENT CERTIFICATES TO THE YOUNG PEOPLE WHO ACHIEVE A GREAT 

8 DEAL ACADEMICALLY BECAUSE THAT IS THEIR FUTURE. AND WE DO 

9 WHATEVER WE CAN. WHEN GOVERNMENT CANNOT PROVIDE CERTAIN 

10 THINGS, WE TRY TO PROVIDE THOSE THINGS. SO THANK YOU. 

11 [APPLAUSE.] 

12

13 SPEAKER: ON BEHALF OF DIRECTOR TRISH PLOEHN, WHO COULDN'T BE 

14 HERE TODAY, I WANT TO THANK SUPERVISOR ANTONOVICH AND THE 

15 WHOLE BOARD FOR YOUR SUPPORT OF THESE CHILDREN. WE HAVE 17,000 

16 YOUTH IN CARE RIGHT NOW. EVERYONE IS SPECIAL, BUT THESE ONES 

17 BEFORE US HERE TODAY HAVE DONE A TERRIFIC JOB WITH THEIR 

18 EDUCATION, THEIR COMMITMENT. AND THAT'S WHAT IT'S ALL ABOUT. 

19 SO THANK YOU VERY MUCH. [APPLAUSE.] 

20

21 SUP. ANTONOVICH: NOW WE WANT TO BRING UP DR. BRUCE SOLHEIM, 

22 MANUEL MARTINEZ, GINGER DE VILLA-ROSE IN RECOGNITION OF THEIR 

23 HARD WORK AND LEADERSHIP TO INITIATE THE "BOOTS TO BOOKS" 

24 PROGRAM, WHICH HAS HELPED ASSIST DEPLOYED, POST-DEPLOYED AND 

25 VETERAN STUDENTS WHO MAKE A POSITIVE TRANSITION FROM MILITARY 
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1 TO CIVILIAN LIFE OR FROM DEPLOYMENT TO POST-DEPLOYMENT LIFE. 

2 STARTED IN CITRUS COLLEGE IN GLENDORA, "BOOTS TO BOOKS" IS A 

3 NEW COURSE FOR ALL VETERANS AND CURRENT MILITARY MEMBERS, 

4 THEIR FAMILY AND FRIENDS AND SUPPORTERS. THE CURRICULUM WAS 

5 DEVELOPED TO HELP THE DEPLOYED, POST-DEPLOYED AND VETERAN 

6 STUDENTS TO SUCCEED IN ACADEMICS, WORK, FAMILY AND OTHER 

7 SOCIAL SETTINGS. THE COURSE TEACHES STUDENTS HOW TO ADAPT TO 

8 COLLEGE LIFE, UNDERSTAND PROBLEMS VETERANS OF PREVIOUS WARS 

9 HAVE ENCOUNTERED, DEVELOP COPING SKILLS TO DEAL WITH STRESS, 

10 LEARN PROBLEM SOLVING, INTERPERSONAL CONFLICT RESOLUTION, 

11 ALERT ASSERTIVENESS, SKILLS, APPLY EFFECTIVE STUDY SKILLS FOR 

12 THEIR CLASSES AND OTHER COLLEGE COURSES. WITH THEIR SERVICE, 

13 THEIR SACRIFICE AND COURAGE, OUR VETERANS HAVE EARNED OUR 

14 PERMANENT GRATITUDE AND RESPECT. SO WE WANT TO ONCE AGAIN 

15 RECOGNIZE THESE INDIVIDUALS. AND I'LL GIVE PROCLAMATIONS FIRST 

16 TO MANUEL MARTINEZ. 

17

18 MANUEL MARTINEZ: THANK YOU VERY MUCH. 

19

20 SUP. ANTONOVICH: AND DR. BRUCE SOLHEIM. AND GINGER DE VILLA-

21 ROSE. 

22

23 MANUEL MARTINEZ: I ACCEPT THIS AWARD ON BEHALF OF ALL THE 

24 COMBAT VETERANS AND THEIR FAMILIES THAT I HAVE WORKED WITH 

25 OVER THE PAST 22 YEARS AS A COUNSELING THERAPIST WITH THE 
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1 DEPARTMENT OF VETERANS AFFAIRS VET CENTER PROGRAM. IT'S THEIR 

2 STRUGGLE AND THEIR LIVES HAVE CONTRIBUTED IMMENSELY TO THE 

3 CURRICULUM. IT'S AMAZING HOW SYNCHRONICITY HAD COME TOGETHER 

4 IN FORGING A FRIENDSHIP AND A PARTNERSHIP WITH DR. BRUCE 

5 SOLHEIM AND GINGER DE VILLA-ROSE HERE AND MAKING THE COURSE A 

6 SUCCESS AT CITRUS COLLEGE. I'M OVERWHELMED BY THE RECOGNITION 

7 THAT WE'RE RECEIVING HERE, ESPECIALLY TO SUPERVISOR MIKE 

8 ANTONOVICH FOR HIS SENSITIVITY TO THE VETERAN COMMUNITY AND 

9 HIS CONTRIBUTION TO THE VETERANS' NEEDS. ALSO, TOO, THAT 

10 RECOGNIZE THAT IT TAKES A VILLAGE TO BRING A SOLDIER HOME. AND 

11 I REALLY WANT TO THANK THE BOARD HERE FOR BEING PART OF THAT 

12 VILLAGE. THANK YOU VERY MUCH. [APPLAUSE.] 

13

14 DR. BRUCE SOLHEIM: I WANTED TO THANK SUPERVISOR ANTONOVICH AND 

15 JAY GOMEZ, TOO, WHO HAS BEEN A BIG SUPPORTER OF OURS 

16 THROUGHOUT THE LAST COUPLE YEARS DEVELOPING "BOOTS TO BOOKS." 

17 AND I JUST WANTED TO SAY WE WERE THE FIRST COLLEGE IN THE 

18 NATION TO OFFER SUCH A TRANSITION COURSE. AND NOW I CAN 

19 PROUDLY SAY THERE'S PROBABLY A DOZEN OR MORE. NOT JUST HERE IN 

20 THE STATE OF CALIFORNIA BUT NATIONWIDE. AND IT'S GROWING BY 

21 LEAPS AND BOUNDS. WE'VE EVEN BEEN CONTACTED BY TROOPS IN IRAQ 

22 THAT WANT TO GET A HEAD START ON THEIR EDUCATION AND THEIR 

23 TRANSITION. SO I'M VERY PROUD OF THESE TWO AND THE WORK THAT 

24 WE'RE DOING. AND THANK YOU VERY MUCH. [APPLAUSE.] 

25



December 9, 2008

23

1 GINGER DE VILLA-ROSE: WOW, I THINK THEY'VE SAID IT ALL. BUT 

2 THANK YOU VERY MUCH. THIS IS VERY EXCITING. THANK YOU. 

3

4 SUP. ANTONOVICH: AND NOW WE HAVE LITTLE TEDDY, WHO IS A 

5 YORKSHIRE TERRIER WHO IS SEVEN MONTHS OLD, WHO IS LOOKING FOR 

6 A HOME AND SHE COMES WITH THE SWEATER. IT'S A LITTLE BOY. SO 

7 IT'S 562-728-4644. OR ANYBODY IN THE AUDIENCE WHO WOULD LIKE 

8 TO ADOPT LITTLE TEDDY? LITTLE TEDDY IS LOOKING FOR A HOME. 

9 MAYBE SHE'D LIKE TO GO TO CITRUS COLLEGE. [LAUGHTER.] SO 

10 ANYBODY LIKE TO ADOPT LITTLE TEDDY IN THE AUDIENCE OR AT HOME. 

11 THERE ARE A LOT MORE LITTLE TEDDIES IN OUR SHELTERS, AS WELL. 

12 THANK YOU. 

13

14 SUP. MOLINA: THANK YOU, SUPERVISOR ANTONOVICH. I FORGET I HAD 

15 THIS MIKE HERE. IS THIS ON? IT IS. I'M GOING TO ASK A VERY 

16 SPECIAL GROUP OF PEOPLE TO COME UP AND JOIN ME. THIS IS THE 

17 LEADERSHIP TEAM OF OUR SKID ROW ASSESSMENT TEAM. I'M GOING TO 

18 ASK THEM TO COME UP AND JOIN ME. THIS MORNING, WE HAD A VERY 

19 SPECIAL RECOGNITION THAT WE DID UPSTAIRS, OF A TEAM OF PEOPLE 

20 WHO HAVE BEEN INVOLVED IN THIS OUTSTANDING WORK. I'M SO VERY 

21 PROUD OF ALL OF THEM. YOU KNOW, OUR BOARD, IN 2004, ADOPTED A 

22 ZERO TOLERANCE FOR CHILDREN ON SKID ROW. AND OF COURSE IT WAS 

23 AN AWESOME TASK AT THAT TIME TO THINK THAT WE COULD ELIMINATE 

24 ALL OF THE CHILDREN FROM SKID ROW. BUT WE'VE PUT TOGETHER A 

25 TEAM OF FOLKS FROM ALL THE VARIOUS DEPARTMENTS. WE STARTED 
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1 STRATEGIZING, TRYING TO CREATE A PROCESS AND A MECHANISM AS TO 

2 HOW TO MAKE THAT ALL HAPPEN. I SAID EARLIER TO THE GROUP THAT 

3 IT ALL WAS A COMBINATION OF A LOT OF PERSONAL PASSION. I THINK 

4 THAT WHILE INITIALLY WE WERE MET WITH A LOT OF SKEPTICISM. A 

5 LOT OF PEOPLE WHO DIDN'T TRUST WHAT WE WERE TRYING TO DO. MANY 

6 PEOPLE ACCUSING US OF TRYING TO CRIMINALIZE POVERTY. BUT, 

7 INSTEAD, I THINK ALL OF US CLEARLY UNDERSTOOD THAT OUR MISSION 

8 WAS TO SAVE CHILDREN, TO CREATE STABILITY FOR THESE CHILDREN, 

9 TO CREATE A PATHWAY FOR STABILITY FOR THEIR PARENTS AND 

10 CERTAINLY TO MAKE SURE THAT THESE CHILDREN WOULD BE SAFE NOW 

11 AND IN THE FUTURE. THIS TEAM HAS DONE AN UNBELIEVABLE JOB. I 

12 CANNOT SAY ENOUGH ABOUT THEM. THEY'VE BEEN OUTSTANDING IN, AS 

13 I SAY, REALLY THINKING AND CRITICALLY THINKING ABOUT HOW TO 

14 SAVE THESE FAMILIES. EVERY SINGLE FAMILY STORY IS TRULY 

15 UNIQUE. THEY ALL HAVE VERY SPECIAL NEEDS. AND THEY ALL REALLY 

16 REQUIRE SPECIAL ATTENTION. WHAT WE'VE HAD IN THE PEOPLE THAT 

17 ARE OUT IN THE FIELD IS THE ABILITY TO ASSESS, TO UNDERSTAND, 

18 TO APPRECIATE THE SITUATION, BUT MORE IMPORTANTLY TO CONNECT 

19 THEM WITH THE KIND OF SUPPORTIVE SERVICES THAT ARE GOING TO 

20 HELP THESE FAMILIES OUT OF HOMELESSNESS AND ONTO A POSITIVE 

21 PATHWAY, NOT ONLY FOR THEMSELVES BUT CERTAINLY FOR THEIR 

22 CHILDREN. WE HAVE BEEN ABLE TO, I THINK, ESTABLISH A MODEL, 

23 TRULY A MODEL OF HOW TO MOVE FORWARD TO CREATE ZERO TOLERANCE 

24 FOR ANY CHILD IN HOMELESSNESS. IT IS A TOUGH, TOUGH JOB. BUT 

25 THE REALITY IS IF YOU SURROUND THE FAMILY WITH ALL THE 
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1 SUPPORTIVE SERVICES, HAVE CONSTANT GUIDANCE THAT NEEDS TO BE 

2 PROVIDED TO THEM ON A REGULAR BASIS AND MOVE FORWARD IN A WAY 

3 THAT IS A REAL PARTNERSHIP WITH A FAMILY, YOU CANNOT ONLY SAVE 

4 THESE FAMILIES BUT MORE IMPORTANTLY REALLY PROVIDE SAFETY FOR 

5 THE CHILDREN. AND IT HAS BEEN AN UNBELIEVABLE COLLABORATION. 

6 AND I WANT TO THANK ALL OF THE PEOPLE THAT WERE HERE. WE'RE 

7 GOING TO RECOGNIZE THE LEADERSHIP. BECAUSE WITHOUT THE 

8 LEADERSHIP, IT WOULDN'T HAVE HAPPENED. SO THERE ARE MANY 

9 DEPARTMENTS. BUT FIRST OF ALL, I THINK ALL OF US WANT TO THANK 

10 THE FRONTLINE FOLKS THAT WERE OUT THERE EVERY SINGLE DAY, MANY 

11 OF THEM RECEIVED -- PLEASE STAND UP. [APPLAUSE.] I'D LIKE YOU 

12 TO SEE THE FACES OF THESE UNBELIEVABLE CHAMPIONS FOR CHILDREN. 

13 WE ARE VERY, VERY PROUD OF YOU. AND WE THANK YOU SO VERY MUCH. 

14 BUT LET ME MOVE FORWARD TO THANK SOME OF THE FOLKS THAT HAVE 

15 BEEN INSTRUMENTAL IN PUTTING THIS TOGETHER. OF COURSE THIS 

16 TEAM WAS HEADED UP BY THE DEPARTMENT OF CHILDREN AND FAMILY 

17 SERVICES. IT WAS TOUGH INITIALLY BECAUSE THEY HAD THE LARGEST 

18 RESPONSIBILITY TRYING TO PUT TOGETHER SOME OF THE VERY BEST 

19 PEOPLE TO ASSIST US OUT THERE. AND THEY WERE VERY, VERY 

20 SUCCESSFUL IN REALLY MEETING THE CHALLENGE, WHICH WAS A TOUGH 

21 ONE OUT THERE BECAUSE AS USUAL, THEY ARE ALWAYS ON THE OTHER 

22 END OF IT ONCE A CHILD IS ABUSED, ONCE A CHILD IS NOT PROVIDED 

23 SAFETY, THEY COME IN. SOMETIMES THEY'RE NOT AS INVOLVED IN THE 

24 PREVENTIVE ASPECT OF IT. SO HERE THEY WERE, AND THEY PUT 

25 TOGETHER AN UNBELIEVABLE PROGRAM. SO I WANT TO BRING UP TED 
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1 MEYERS. YOU DIDN'T SEE US THROUGH ALL OF THIS, BUT YOU WERE 

2 PART TOWARD THE END THERE. 

3

4 TED MEYERS: I'M HERE FOR THE GOOD TIMES. 

5

6 SUP. MOLINA: THAT'S RIGHT. AND IT IS A GOOD TIME. AS SOME OF 

7 THESE DEPARTMENTS WILL WELL KNOW. THEY WERE REALLY ROUGH 

8 TIMES. WE WANT TO CONGRATULATE YOU AND THE DEPARTMENT FOR AN 

9 OUTSTANDING JOB AND THE LEADERSHIP. 

10

11 TED MEYERS: THANK YOU VERY MUCH, SUPERVISOR. 

12

13 SUP. MOLINA: CONGRATULATIONS, SIR. [APPLAUSE.] WELL, WE NEEDED 

14 TO MAKE SURE THAT NOT ONLY ARE CHILDREN SAFE, BUT THEY ARE 

15 ALSO HEALTHY. WE ALWAYS NEEDED TO HAVE OUR PUBLIC HEALTH 

16 NURSES OUT THERE. AND LEADING THAT TEAM WAS THE LEADERSHIP OF 

17 MR. JONATHAN FIELDING. I WANT TO CONGRATULATE, FROM OUR 

18 DEPARTMENT OF PUBLIC HEALTH OUTSTANDING JOB. CONGRATULATIONS. 

19 WE ARE PROUD OF THE WORK THAT THEY DID OUT THERE. [APPLAUSE.] 

20 CONGRATULATIONS. 

21

22 DR. JONATHON FIELDING: THANK YOU, SUPERVISOR. 

23

24 SUP. MOLINA: AS WE KNOW, SO MANY OF OUR FAMILIES OUT THERE 

25 CERTAINLY ARE NOT THERE BECAUSE THEY WANT TO BE THERE. AND 
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1 MANY OF THEM HAVE A LOT OF MENTAL HEALTH ISSUES. AND THOSE ARE 

2 THE MOST DELICATE ISSUES TO TRY AND WORK THROUGH. IT REALLY 

3 REQUIRES A VERY, VERY UNIQUE TEAM OF FOLKS THAT CAN APPROACH 

4 AN INDIVIDUAL, THAT CAN DO IT WITH A KIND OF, YOU KNOW, 

5 RESPONSIBILITY THAT IS ALSO NOT GOING TO SCARE FOLKS OFF AND 

6 CERTAINLY NOT BE JUDGMENTAL. WELL, WE HAVE HAD A WONDERFUL 

7 COLLABORATION WITH OUR DEPARTMENT OF MENTAL HEALTH, WHO PUT 

8 TOGETHER A TEAM OF FOLKS THAT WAS VERY WORRIED INITIALLY OF 

9 WHAT THEY WERE GOING TO BE DOING OUT THERE. BUT I THINK AT THE 

10 END OF THE DAY, THEY ALSO APPRECIATE THE TREMENDOUS EFFORTS 

11 THAT THEY HAVE DONE. AND I AM SO PROUD OF THE DEPARTMENT OF 

12 MENTAL HEALTH AND THEIR LEADERSHIP ROLE IN THIS AREA. MARV, 

13 CONGRATULATIONS AND THANK YOU. [APPLAUSE.] CONGRATULATIONS. 

14 AND, OF COURSE, WE ALL KNOW THAT MANY OF THESE FAMILIES IN 

15 MANY INSTANCES HAVE EXHAUSTED THE RESOURCES THAT THEY HAVE 

16 UNDER OUR WELFARE SYSTEM OR OTHER THINGS OF THAT SORT. IT 

17 REALLY ALSO REQUIRED A TEAM TO PUT TOGETHER THE KIND OF 

18 RESOURCES THAT WERE NECESSARY IN ORDER TO PUT THESE FAMILIES 

19 ON A POSITIVE PATHWAY, WHETHER IT BE HOUSING VOUCHERS, WHETHER 

20 IT BE CASH ASSISTANCE OR OTHER KINDS OF THINGS. AND IT WAS OUR 

21 DEPARTMENT OF PUBLIC SOCIAL SERVICES THAT WAS REALLY -- THAT 

22 DID AN OUTSTANDING JOB IN PUTTING THAT TOGETHER. AND I WANT TO 

23 THANK YOU, MR. BROWNING, FOR YOUR LEADERSHIP. 

24

25 PHILLIP BROWNING: THANK YOU, MA'AM. 
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1

2 SUP. MOLINA: AND A GREAT STAFF THAT YOU HAVE AT THE 

3 DEPARTMENT. [APPLAUSE.] THANK YOU, SIR. 

4

5 PHILLIP BROWNING: COULD I SAY ONE THING? 

6

7 SUP. MOLINA: SURE. 

8

9 PHILLIP BROWNING: I'D LIKE TO SAY ONE THING. I DO SO 

10 APPRECIATE THE SUPERVISOR'S LEADERSHIP. WITHOUT HER 

11 LEADERSHIP, THIS PROJECT WOULD HAVE NEVER GOTTEN OFF THE 

12 GROUND. HER DEPUTIES OVER THERE, LOUISA AND MARTHA, THEY HAVE 

13 DONE SUCH A FANTASTIC JOB. [APPLAUSE.] 

14

15 SUP. MOLINA: CONGRATULATIONS. 

16

17 PHILLIP BROWNING: AND I WOULD LIKE TO HAVE A ROUND OF APPLAUSE 

18 FOR THE SUPERVISOR. SHE MADE THIS PROJECT WORK. THANK YOU. 

19 [APPLAUSE.] 

20

21 SUP. MOLINA: YOU KNOW, THE ISSUE OF HOMELESSNESS IS 

22 EVERYWHERE. BUT WHEN WE LOOKED AT THIS ISSUE, WE CERTAINLY 

23 NEEDED TO WORK WITH THE CITY OF LOS ANGELES. WE WENT WITH THE 

24 MAYOR, WITH HIS HOUSING FOLKS, TO TALK ABOUT HOW TO ADDRESS 

25 IT. THEY WERE VERY SUPPORTIVE. AND OF COURSE WE NEEDED THEIR 
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1 ASSISTANCE AS FAR AS GETTING THE KIND OF VOUCHERS THAT WE NEED 

2 IN ORDER TO PROVIDE SHELTER FOR THESE FAMILIES. AND I WANT TO 

3 THANK THE HOUSING AUTHORITY OF THE CITY OF L.A. AND ITS LEADER 

4 TODAY FOR AN OUTSTANDING JOB. CONGRATULATIONS TODAY. 

5 [APPLAUSE.] 

6

7 SPEAKER: AGAIN, THANK YOU SO MUCH. AND IT'S A GREAT HONOR TO 

8 BE BEFORE THIS HONORABLE BODY OF SUPERVISORS. I'D LIKE TO 

9 RECOGNIZE THE LEADERSHIP OF SUPERVISOR MOLINA. AND REALLY TALK 

10 ABOUT WHAT A BEAUTIFUL OPPORTUNITY TO PARTNER, COUNTY AND 

11 CITY, IN THIS VERY WORTHY ENDEAVOR TO GET FAMILIES OFF OF SKID 

12 ROW, TO GET KIDS OFF OF SKID ROW. THIS IS VERY ALIGNED WITH 

13 MAYOR VILLARAIGOSA'S INITIATIVES TO REDUCE AND ADDRESS 

14 HOMELESSNESS IN THE CITY. I'VE GOT TO TELL YOU, I'VE GOT TO 

15 TAKE MY HAT OFF TO THE BEST SECTION 8 DIRECTOR IN THE COUNTRY, 

16 LOURDES CASTRO AND TEAM. BECAUSE WITHOUT THIS, IT WOULDN'T 

17 HAVE HAPPENED. THANK YOU. [APPLAUSE.] 

18

19 SUP. MOLINA: YOU KNOW, THE OTHER PART OF IT IS HOW DO YOU 

20 CREATE A MECHANISM TO SORT OF MAKE SURE YOU'RE PROVIDING A 

21 GUIDING HAND TO THESE FAMILIES WITHOUT BEING OVERLY INTRUSIVE 

22 AND TOO INTRUSIVE IN THEIR LIVES BUT AT THE SAME TIME HAVING 

23 AN AWFUL LOT OF ACCOUNTABILITY? BECAUSE THAT'S REALLY THE KEY, 

24 IS TRYING TO MAKE SURE THAT THESE FAMILIES START OPERATING IN 

25 A MORE RESPONSIBLE FASHION, BUT ALSO MAKING SURE THAT THEY 
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1 UNDERSTAND THAT THERE ARE RESOURCES AND SUPPORTIVE SERVICES 

2 AVAILABLE TO THEM. AND OF COURSE BRINGING ACCOUNTABILITY ALL 

3 THE WAY THROUGH THAT. WELL, THE CHAMPION THAT WE HAD IN THAT 

4 REGARD IS SOMEONE WHO HAS A LONG HISTORY IN THE ISSUES OF 

5 HOUSING AND HOMELESSNESS. SHE HAS CREATED SOLUTION AFTER 

6 SOLUTION. AND WE WERE STILL HAVING A TOUGH, TOUGH TIME WHEN WE 

7 CAME ACROSS THIS. BECAUSE IT WASN'T JUST PUTTING THEM INTO 

8 HOUSING. THAT WASN'T THE ANSWER. AND IT ISN'T THE ANSWER 

9 EXCLUSIVELY TO HOMELESSNESS. IT IS REALLY CREATING A POSITIVE 

10 PATHWAY, HAVING THE KIND OF SYSTEM THAT IS GOING TO MAKE SURE 

11 YOU'RE EMPOWERING THESE FAMILIES SO THAT THEY CAN SORT THESE 

12 THINGS OUT ON THEIR OWN. AND OF COURSE WE HAD A REAL CHAMPION 

13 WHO JOINED US IN THIS EFFORT WHO UNDERSTOOD IT FROM DAY ONE, 

14 WHO SAID "THIS IS HOW WE'RE GOING TO DO IT. THIS IS WHAT WE 

15 NEED TO GET IT DONE. AND THIS IS HOW WE'RE GOING TO WORK IT 

16 ALL OUT." AND WHAT WE HAVE DONE IS WE HAVE SAVED OVER 700 

17 CHILDREN, OVER 1,000 FAMILIES. THAT CANNOT BE IGNORED. AND WE 

18 ARE GOING TO HAVE A TOUGH TIME IN THE FUTURE BECAUSE WE STILL 

19 HAVE AN AWFUL LOT OF WORK TO DO. BUT I AM HOPING THAT THIS 

20 MODEL WILL BE REPLICATED IN MANY OTHER AREAS. AND ONE OF OUR 

21 CHAMPIONS IN THAT REGARD IS SOMEONE WHO WE PARTNERED FROM THE 

22 OUTSIDE WHO HAS RUN AN UNBELIEVABLE NONPROFIT AND THAT'S OUR 

23 VERY OWN TANYA TULL. CONGRATULATIONS TANYA. YOU DID AN 

24 OUTSTANDING JOB. [APPLAUSE.] 

25
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1 TANYA TULL: THIS HAS BEEN, FOR ME, CLOSE TO 30 YEARS IN THE 

2 FIELD WORKING, STARTING IN 1980 AS THE FOUNDER OF PARA LOS 

3 NINOS IN L.A.'S SKID ROW, AND THEN FOUNDING BEYOND SHELTER IN 

4 1988 TO HELP FAMILIES OUT OF THE SHELTER SYSTEM, NOT INTO 

5 OTHER SHELTER BUT INTO PERMANENT HOUSING AND THEN HELPING THEM 

6 STABILIZE AND REINTEGRATE BACK INTO COMMUNITY AND RESIDENTIAL 

7 NEIGHBORHOODS THROUGHOUT L.A. COUNTY. TO BE ABLE TO PARTNER 

8 AFTER ALL THOSE YEARS WITH L.A. COUNTY AND THE HOUSING 

9 AUTHORITY, THE CITY OF LOS ANGELES HAS BEEN AN INCREDIBLE 

10 EXPERIENCE, BECAUSE ONLY WITH THAT KIND OF A COLLABORATION ARE 

11 WE TRULY ABLE, TAKING ALL THE PARTNERS THAT HAVE SOMETHING TO 

12 DO WITH THE DIFFERENT PARTS OF THESE MOST VULNERABLE FAMILY 

13 LIVES, ONLY THEN WERE WE ABLE TO DO OUR JOB CORRECTLY. AND 

14 THAT IS: END HOMELESSNESS FOR FAMILIES WITH CHILDREN WHO, 

15 BECAUSE THE SHELTERS ARE FULL, END UP SEEKING A PLACE TO SLEEP 

16 FOR THE NIGHT IN L.A.'S SKID ROW. FROM THIS PROJECT, WE NOW 

17 HAVE DEVELOPED A DIVERSION MODEL THAT WILL KEEP FAMILIES FROM 

18 GOING INTO SKID ROW AND THAT WILL HELP FAMILIES WHO GET SENT 

19 THERE INADVERTENTLY BECAUSE PEOPLE DON'T KNOW THERE'S A BETTER 

20 WAY BACK OUT INTO COMMUNITIES. WE ARE A CIVIL SOCIETY THAT 

21 KNOWS -- WE KNOW WE HAVE TO TAKE CARE OF THOSE WHO CAN'T CARE 

22 FOR THEMSELVES. AND WITH THE SUPERVISOR'S LEADERSHIP, WE GOT 

23 TO DO IT THIS TIME SUCCESSFULLY. I THANK YOU VERY MUCH, 

24 SUPERVISOR MOLINA, FOR LETTING US PARTICIPATE. [APPLAUSE.] 

25
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1 SUP. MOLINA: NOW, THERE'S A TEAM OF PEOPLE, AS WE WERE SORTING 

2 THIS OUT, AND THEY PROBABLY HAD THE ROUGHEST TIME OF ALL, 

3 BECAUSE THEY HAD TO SIT IN A ROOM WITH ME AND SORT OUT ALL OF 

4 THESE PROCESSES AND PROCEDURES, AND MARTHA AND LUISA ON AN 

5 ONGOING BASIS. I'M TOUGH, BUT YOU SHOULD SEE THESE TWO LADIES 

6 WITH ALL OF THEM. AND SO FOR THE COMBAT, I MEAN WE CAN'T GIVE 

7 THEM COMBAT PAY AS THEY DESERVE, BUT WE'RE GIVING THEM 

8 CERTIFICATES. SO I HOPE THEY APPRECIATE IT. [LAUGHTER.] IT 

9 AIN'T THE BEST BUT IT'S SOMETHING. LET ME FIRST OF ALL THANK 

10 THERESA REPEL. THANK YOU SO MUCH. YOU DID AN OUTSTANDING JOB. 

11 [APPLAUSE.] CONGRATULATIONS. THANK YOU SO MUCH. 

12 CONGRATULATIONS. WE HAVE LARRY HEARST. THERE YOU ARE. 

13 CONGRATULATIONS. THANK YOU. YOU DID A WONDERFUL JOB. HE WAS 

14 REALLY WORRIED FOR A WHILE. [LAUGHTER.] ANGELA FLOWERS? THERE 

15 YOU ARE. CONGRATULATIONS. WE THANK YOU. YOU DID A FANTASTIC 

16 JOB. [APPLAUSE.] JASMINE TARVER. SHE'S IN AUSTIN, TEXAS, 

17 COULDN'T JOIN US. LOURDES CASTRO-RAMIREZ. THANK YOU. 

18 CONGRATULATIONS, LOURDES. THANK YOU. [APPLAUSE.] CARLOS VAN 

19 MATTER. CONGRATULATIONS. THANK YOU FOR YOUR HELP. 

20

21 CAROLS VAN MATTER: YOU'RE WELCOME. 

22

23 SUP. MOLINA: THERE WE GO. LISA WONG. THANK YOU, LISA. 

24 CONGRATULATIONS. THANK YOU. [APPLAUSE.] DOLORES CHAVEZ. THANK 

25 YOU, DOLORES. [APPLAUSE.] LILIA URBITI. THERE YOU GO. THANK 
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1 YOU. [APPLAUSE.] AND KATHY HOUSE. THANK YOU, KATHY. 

2 [APPLAUSE.] GREAT. YOU KNOW, AGAIN, I JUST CAN'T SAY ENOUGH. I 

3 USUALLY DON'T DO A LOT OF SCROLLS PRESENTATIONS AND OTHERS. I 

4 THINK PEOPLE WHO ARE HIRED LIKE MANY OF US TO DO THIS PUBLIC 

5 SERVICE DO IT BECAUSE IT IS OUR JOB, IT IS OUR RESPONSIBILITY. 

6 BUT WHEN PEOPLE STEP OUT AS IMPRESSIVELY AS THIS TEAM OF 

7 PEOPLE HAVE TO DO UNBELIEVABLE WORK, I JUST HAVE TO BE A PART 

8 OF CONGRATULATIONS THEM. AND I WANT TO THANK THEM. I WANT TO 

9 JOIN WITH EVERYONE ELSE IN THANKING MY STAFF PEOPLE. THEY ALSO 

10 WENT THROUGH AN AWFUL LOT TO GET HERE. BUT MARTHA? [APPLAUSE.] 

11 LUISA? THANK YOU. AVIANA? SO MANY PEOPLE WERE INVOLVED IN IT. 

12 THEY DID AN OUTSTANDING JOB. THEY'RE GOING TO CONTINUE TO SAVE 

13 CHILDREN. WE KNOW WE'RE GOING THROUGH A TOUGH ECONOMIC TIME. 

14 WE KNOW WE'RE GOING TO SEE MANY MORE CHILDREN. HOPEFULLY NOT 

15 IN SKID ROW. BUT HOPEFULLY WE CAN SAVE SO MANY MORE. BUT WE 

16 KNOW HOW TO DO IT NOW. WE KNOW HOW TO DO IT VERY WELL. AND 

17 WE'RE VERY PROUD OF ALL OF OUR EFFORTS. CONGRATULATIONS TO ALL 

18 OF US. [APPLAUSE.] CAN WE TAKE ONE LAST PICTURE? 

19

20 SUP. MOLINA: ALL RIGHT. I'M GOING TO ASK JONATHAN FIELDING. I 

21 SAW HIM A MINUTE AGO. JONATHAN, I THINK HE'S GOING TO COME UP. 

22 RIGHT? OH. YOU'RE GOING TO BE DOING IT? I'M SORRY. DR. 

23 FIELDING IS GOING TO JOIN US THIS MORNING TO ADDRESS THE 

24 ISSUES OF VACCINATIONS. PLEASE, SIR. 

25
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1 DR. JONATHAN FIELDING: THANK YOU. THIS IS NATIONAL FLU 

2 VACCINATION WEEK. AND FOR MOST PEOPLE, THEY THINK, "WELL FLU, 

3 GEE, THAT'S SOMETHING I THOUGHT ABOUT IN THE EARLY FALL." BUT 

4 ACTUALLY THE HEIGHT OF THE FLU SEASON IS USUALLY AFTER THE 

5 FIRST OF THE YEAR. IT AVERAGES PROBABLY FEBRUARY AT ITS 

6 HEIGHT, SOMETIMES AS LATE AS APRIL OR EVEN MAY. AND SO IT IS 

7 NOT TOO LATE TO GET YOUR FLU SHOT. FLU SHOTS ARE EFFECTIVE TO 

8 PREVENT 70 TO 90 PERCENT OF CASES OF INFLUENZA IN THOSE UNDER 

9 65 AND TO HELP REDUCE THE RATE OF COMPLICATIONS OF THOSE OVER 

10 65. AND SO IF YOU HAVEN'T GOTTEN YOUR FLU SHOT, NOW WOULD BE A 

11 VERY GOOD TIME TO DO IT. THERE'S CERTAIN GROUPS WE'RE 

12 PARTICULARLY CONCERNED ABOUT. INDIVIDUALS WITH CHRONIC 

13 CONDITIONS SUCH AS DIABETES OR CARDIOVASCULAR DISEASE OR 

14 RESPIRATORY PROBLEMS, HEALTHCARE WORKERS, CHILDREN ABOVE THE 

15 AGE OF SIX MONTHS, PREGNANT WOMEN, AND ANYBODY WHO WORKS WITH 

16 PEOPLE WHO ARE AT RISK OF COMPLICATIONS IF THEY GET INFLUENZA. 

17 IT IS NOT TOO LATE. THERE IS A LOT OF VACCINE OUT THERE. CALL 

18 YOUR PHYSICIAN. AND IF YOU DON'T HAVE THE RESOURCES OR DON'T 

19 HAVE THE AVAILABILITY, YOU CAN CALL 211. WE HAVE FLU CLINIC, 

20 FLU VACCINES STILL AVAILABLE IN OUR CLINICS. OUR OUTREACH 

21 PROGRAM IS OVER, BUT WE HAVE IT AVAILABLE IN OUR CLINICS AND 

22 THERE ARE OTHER PLACES, AS WELL. SO YOU CAN CALL 211 AND GET A 

23 LIST OF THOSE AND THEIR HOURS. IT IS NOT TOO LATE. THIS IS A 

24 GOOD TIME. WE'VE HAD A VERY LIGHT FLU SEASON SO FAR. LET'S 
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1 KEEP IT LIGHT BY ALL GETTING VACCINATED. THANK YOU SO MUCH, 

2 SUPERVISOR. 

3

4 SUP. MOLINA: THANK YOU. WE APPRECIATE IT. [APPLAUSE.] WE HAVE 

5 TO ALL GET OUR FLU SHOTS. OKAY. VERY GOOD. LET'S GO BACK TO 

6 OUR REGULAR AGENDA. SUPERVISOR ANTONOVICH, YOU ARE UP FIRST 

7 FOR YOUR ITEMS. 

8

9 CLERK SACHI HAMAI: MADAME CHAIR PRO TEM AND MEMBERS OF THE 

10 BOARD. ON ITEMS 12 AND 37, SUPERVISOR ANTONOVICH HAD 

11 PREVIOUSLY REQUESTED TO CONTINUE THOSE ITEMS ONE WEEK. IT'S MY 

12 UNDERSTANDING YOU'D LIKE RECONSIDERATION, SUPERVISOR 

13 ANTONOVICH? 

14

15 SUP. MOLINA: 12 AND 13? 

16

17 CLERK SACHI HAMAI: 12 AND 37. AND ON THESE ITEMS, HE WOULD 

18 LIKE TO DIVIDE THE QUESTION. HE WOULD LIKE TO DIVIDE THE 

19 QUESTION TO APPROVE -- THERE'S ONE RECOMMENDATION, WHICH IS 

20 UNDER SECTION 34. AND IT HAS TO DO WITH THE COUNTY CODE 

21 COMPLIANCE WITH FEDERAL TAX LAW AND RELATED I.R.S. RULES. AND 

22 HE WOULD LIKE APPROVAL ON THAT TODAY. AND THEN THE REMAINING 

23 PORTION TO BE CONTINUED ONE WEEK. 

24



December 9, 2008

36

1 SUP. MOLINA: ALL RIGHT. SO WE'RE DIVIDING IT. AND THE ONE 

2 THAT, THAT FIRST PROVISION THAT YOU JUST TALKED ABOUT, OR THAT 

3 PARTICULAR PROVISION? 

4

5 CLERK SACHI HAMAI: SECTION 34. 

6

7 SUP. MOLINA: OKAY. LET'S VOTE ON THAT ITEM FIRST. 

8

9 CLERK SACHI HAMAI: THIS IS ON ITEM 12. 

10

11 SUP. MOLINA. ITEM 12. 

12

13 >>CLERK SACHI HAMAI: AND 37. 

14

15 SUP. MOLINA: OKAY. DO YOU WANT TO CALL THE ROLL ON THAT ITEM? 

16 IS THAT HOW YOU WANT TO DO IT? OR IS IT SUPERVISOR ANTONOVICH 

17 IS JUST VOTING NO ON THAT ITEM? 

18

19 CLERK SACHI HAMAI: NO, YOU WOULD LIKE APPROVAL, CORRECT? YOU 

20 WOULD LIKE APPROVAL ON SECTION 34 TODAY, CORRECT? 

21

22 SUP. ANTONOVICH: PART AND CONTINUING THE OTHER PART FOR NEXT 

23 WEEK. 

24
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1 SUP. MOLINA: I SEE. SO WE ARE GOING TO MOVE FORWARD ON THAT 

2 ITEM THAT HAS BEEN PULLED OUT AND CONTINUE THE REMAINING ITEM. 

3

4 CLERK SACHI HAMAI: CORRECT. 

5

6 SUP. MOLINA: ALL RIGHT. WITH THAT UNDERSTANDING, IT HAS BEEN 

7 MOVED BY SUPERVISOR ANTONOVICH, SECONDED BY SUPERVISOR 

8 YAROSLAVSKY. THERE IS NO OBJECTION, SO ORDERED. 

9

10 CLERK SACHI HAMAI: THANK YOU, MADAME CHAIR PRO TEM. 

11

12 SUP. ANTONOVICH: MADAME CHAIR, I'D LIKE TO MOVE THAT WE 

13 ADJOURN IN MEMORY TODAY OF THE FOLLOWING, THE HONORABLE VERN 

14 ORD, WHO WAS A FRIEND AND SUPPORTER WHO HAD SERVED OUR NATION, 

15 STATE AND COUNTRY IN BUSINESS, MILITARY, GOVERNMENT, AND 

16 EDUCATION WITH DISTINCTION FOR MANY, MANY YEARS. HE PASSED 

17 AWAY AT HIS PASADENA HOME AT THE AGE OF 92 THIS PAST WEEK. HE 

18 WAS THE FORMER DIRECTOR OF THE CALIFORNIA DEPARTMENT OF MOTOR 

19 VEHICLES. HE WAS AIR FORCE SECRETARY UNDER THE REAGAN 

20 ADMINISTRATION. AND AS THE AIR FORCE SECRETARY, HE CHAMPIONED 

21 THE B1 BOMBER PROGRAM, WHICH HAD BEEN CANCELED BY PRESIDENT 

22 JIMMY CARTER. AND IF YOU LOOKED UP IN THE SKY THIS PAST 

23 SATURDAY, YOU WOULD HAVE SEEN THE B1 BOMBER FLYING OVER FOR 

24 HIS FUNERAL IN PASADENA AT THE CHURCH. HIS ORDER ACTIVATED THE 

25 PROGRAM AND WAS A CREW MEMBER OF THE FIRST 100 PLANES THAT WAS 
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1 DELIVERED AHEAD OF SCHEDULE IN 1981. I HAD THE OPPORTUNITY OF 

2 BEING THERE IN ANTELOPE VALLEY WHEN IT ROLLED OFF THE ASSEMBLY 

3 LINE. HE SERVED AS A LOCAL BUSINESSMAN AND CIVIC LEADER AND 

4 WAS ALSO A REGENT OF THE UNIVERSITY OF CALIFORNIA. HE WAS ALSO 

5 DEAN OF THE BUSINESS SCHOOL AT LAVERNE UNIVERSITY. HE LEAVES 

6 HIS WIFE, SARAH, AND HIS CHILDREN. ANOTHER VERY GOOD FRIEND 

7 AND MENTOR WAS RABBI HENRY KRAUSE. HE WAS ALSO A CHAPLAIN FOR 

8 THE CITY OF HOPE, THE LOS ANGELES SHERIFF'S DEPARTMENT, THE 

9 LOS ANGELES POLICE DEPARTMENT. AND HE WAS RABBI FOR TEMPLE 

10 BETH AMI IN WEST COVINA. HE IS SURVIVED BY HIS DAUGHTER, THREE 

11 GRANDCHILDREN, THREE GREAT GRANDCHILDREN. AND HE WAS A 

12 WONDERFUL, WONDERFUL MAN AND A WONDERFUL FRIEND. JUDGE WILLIAM 

13 HUSS, SUPERIOR COURT JUDGE, WHO PASSED AWAY AT THE AGE OF 76. 

14 HE HAD BEEN APPOINTED TO THE BENCH IN 1989 BY GOVERNOR 

15 DEUKMEJIAN. AND HE SERVED AS A JUDGE AND ALSO AS A MEDIATOR. 

16 FELIX MONTOYA, A MEMBER OF THE SHERIFF'S DEPARTMENT. HE WORKED 

17 IN FOOD SERVICES AT THE NORTH COUNTY CORRECTIONAL FACILITY. 

18 SISTER MARY LOUISE SCHRODT, SISTERS OF ST. JOSEPH OF 

19 CARONDELET SINCE 1943. SHE IS SURVIVED BY HER SISTER, AND 

20 COUSIN AND NIECES. DR. FRANK STRANGES, PASTOR OF MINISTRIES 

21 WORLDWIDE IN LOS ANGELES COUNTY. HE STARTED OFF BY ATTENDING 

22 VALLEY FORGE CHRISTIAN COLLEGE AND WENT ON TO NORTH CENTRAL 

23 UNIVERSITY. HE IS SURVIVED BY HIS WIFE, JULIE, AND HIS THREE 

24 SIBLINGS. ANOTHER WONDERFUL PERSON WHO HAPPENED TO ATTEND MY 

25 BIRTHDAY PARTY RECENTLY WAS BEATRIZ VALDEZ, WHO SERVED THE 
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1 COUNTY OF LOS ANGELES FOR 38 YEARS, STARTING AS A STENOGRAPHER 

2 IN THE REGISTRAR VOTER'S DEPARTMENT BACK IN 1957. AND THEN AS 

3 IT MERGED WITH THE VARIOUS DEPARTMENTS OF COUNTY RECORDER AND 

4 COUNTY CLERK, SHE WAS TAKING ON MORE RESPONSIBILITY. AND SHE 

5 LATER SERVED AS THE ASSISTANT CHIEF DEPUTY AND ASSISTANT 

6 REGISTRAR-RECORDER, UNTIL HER APPOINTMENT IN 1993 AS L.A. 

7 COUNTY'S REGISTAR-RECORDER COUNTY CLERK. SHE RETIRED IN 1995 

8 AFTER IMPLEMENTING NEW SYSTEMS AND PROGRAMS AND MADE VARIOUS 

9 SUCCESSFUL RECOMMENDATIONS FOR LEGISLATION AMENDMENTS TO THE 

10 ELECTIONS CODE FOR IMPROVED ELECTION ADMINISTRATION STATEWIDE. 

11

12 SUP. MOLINA: I THINK ALL MEMBERS WOULD LIKE TO JOIN IN THE BEA 

13 VALDEZ MEMORIAL. 

14

15 SUP. ANTONOVICH: CARL "LES" WOLF WAS AN ELECTRICAL TECHNICIAN. 

16 LATER WORKED AT GENERAL DYNAMICS AND ROCKWELL IN THE ANTELOPE 

17 VALLEY. JAMES T. HALL, ALSO A VETERAN OF THE KOREAN WAR AND 

18 ACTIVE IN THE ANTELOPE VALLEY. JAMES RICHARD DANIELS. HE 

19 SERVED IN THE UNITED STATES NAVY AND ALSO WORKED FOR LOCKHEED 

20 FOR 34 YEARS. HE WORKED ON THE SKUNK WORKS PROGRAMS, INCLUDING 

21 THE F-104, THE U-2, THE SR-71, AND THE F-117. AND WAS INVOLVED 

22 IN THE LAST FLIGHT OF THE SR-71. HE WAS RECIPIENT OF THE KELLY 

23 JOHNSON AWARD, THE FIRST NONMILITARY RECIPIENT. HE WAS ALSO A 

24 MEMBER OF THE AIR PARKS VOLUNTEERS AND ACTIVE IN THE ANTELOPE 

25 VALLEY. CHRISTINE CULLETON. SHE ALSO WAS INVOLVED WITH THE 
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1 WEST SIDE 4-H CLUB, THE ANTELOPE VALLEY FAIR. AND SHE 

2 PARTICIPATED IN THE MISS ANTELOPE ACRES QUEENS CONTEST FOR THE 

3 LAST 20 YEARS. SHE WORKED AT ANTELOPE ACRES MARKET AND 

4 ROCKWELL INTERNATIONAL. JEFF COONROD, ALSO A VETERAN OF THE 

5 UNITED STATES AIR FORCE AND LATER HE WAS INVOLVED IN WORKING 

6 FOR NASA AT EDWARDS AIR FORCE BASE. JUANITA LOUISE COLBURN, 

7 ACTIVE IN THE FAIRVIEW METHODIST CHURCH IN THE ANTELOPE VALLEY 

8 WHERE SHE WAS THE ORGANIST. ALSO INVOLVED IN MANY OTHER 

9 ORGANIZATIONS. MARCIAL CASTRO, BORN IN THE PHILIPPINES, 

10 IMMIGRATED TO THE UNITED STATES IN 1979, WORKED FOR C.N.A. FOR 

11 12 YEARS IN THE CONVALESCENT HOSPITALS AND WAS A SMALL 

12 BUSINESSMAN WHO OWNED AND OPERATED CONCRETE PRODUCTS AND 

13 FARMING. HE SPENT MOST OF HIS EARNINGS SENDING CLOTHING AND 

14 OVER-THE-COUNTER MEDICINES BACK TO HIS OLD NEIGHBORHOOD IN THE 

15 PHILIPPINES. HE WAS VERY KIND HEARTED, AND HE SERVED AS A 

16 SCHOOL BUS FOR THE LOCAL CHILDREN IN THE COMMUNITY. THOSE ARE 

17 MY ADJOURNMENT MOTIONS. 

18

19 SUP. MOLINA: SO ORDERED ON THOSE ADJOURNMENTS. 

20

21 SUP. ANTONOVICH: OKAY. 

22

23 SUP. MOLINA: IF YOU'LL PERMIT ME, MR. ANTONOVICH, I'D LIKE TO 

24 CALL UP SOME OF THE ITEMS THAT HAVE BEEN HELD BY THE PUBLIC, 

25 BY MR. SACHS. MR. SACHS, IF YOU'D COME UP AND JOIN US, WE'D 
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1 LIKE YOU TO ADDRESS THE ITEMS NO. 4, NO. 6, NO. 13, 19, 24 AND 

2 25. 

3

4 ARNOLD SACHS: GOOD MORNING, COUNTY BOARD OF SUPERVISORS. THANK 

5 YOU VERY MUCH. ARNOLD SACHS. 4 AND 6 DEAL WITH HOMELESS ITEMS 

6 ON YOUR AGENDA, SO I'D LIKE TO ADDRESS THEM TOGETHER. THERE 

7 WAS A MISPERCEPTION, I BELIEVE, LAST WEEK. I ASKED ABOUT THE 

8 PROJECT 50. AND I DON'T HAVE A PROBLEM WITH THE INITIATIVES 

9 AND THE WORK BEING DONE. IT'S JUST THE FOCUS. TO SAY THAT IT 

10 IS A SUCCESS FOR THIS PROJECT 50, YOU SPEND $100,000 PER 

11 PERSON, I JUST DON'T SEE THAT AS A SUCCESSFUL PROGRAM. THERE'S 

12 NO WORK DONE THROUGHOUT THE COUNTY, ALTHOUGH THIS IS A COUNTY 

13 ORGANIZATION HERE. ALL THIS WORK WAS FOCUSED IN DOWNTOWN. 

14 NOTHING WAS FOCUSED OUTSIDE THE COUNTY. NOTHING IN ANY OTHER 

15 DISTRICT EXCEPT DOWNTOWN. SO TO SAY THAT IT WAS A SUCCESS, I 

16 DON'T SEE IT AS A SUCCESS EITHER. THE PEOPLE ON THE 

17 FRONTLINES, NOTHING BUT APPLAUSE FOR THEM, BECAUSE THEY'RE THE 

18 ONES THAT FACE THE EVERYDAY REALITIES. THE PROBLEMS THAT THEY 

19 FACE, THOUGH, THAT'S A DIFFERENT QUESTION. BECAUSE THE GROUPS 

20 THAT ARE CREATED, THE HOUSING AUTHORITIES AND THE HELP FOR THE 

21 HOMELESS AUTHORITIES FACE THE PROBLEMS EVERY DAY WHETHER THEY 

22 NEED TO FIND SOMEBODY WITH I.D., THEY NEED TO GET THEM A 

23 SOCIAL SECURITY NUMBER. THEY NEED TO GET THEM OUT OF JAIL. 

24 THESE ARE CONSTANT PROBLEMS FACED BY A LARGE MAJORITY OF THE 

25 HOMELESS. AND TO NOT THINK THAT -- AND I'M LOOKING FROM 
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1 UPDATES -- SEVERAL TIMES I ASKED FROM THE COUNTY BOARD UPDATES 

2 ON THE PROJECT 50. MY UPDATE CAME FROM THE DOWNTOWN L.A. NEWS. 

3 IF YOU HAVE A PROBLEM WITH WHAT I'M SAYING, THEN YOU HAVE A 

4 PROBLEM WITH WHAT THE "L.A. DOWNTOWN NEWS" IS SAYING. THEY SAY 

5 471 PEOPLE WERE INTERVIEWED. HOW WAS IT DONE? CONSENSUS 

6 SCORING? I MEAN THERE IS A DISCONNECT BETWEEN WHAT YOUR 

7 REALITY IS AND WHAT THE REALITY IS OF THE PEOPLE WHO LIVE 

8 OUTSIDE ON THE STREETS AND IN THE REAL WORLD OF L.A. THANK YOU 

9 FOR YOUR TIME, YOUR ANSWERS AND YOUR ATTENTION. 

10

11 SUP. MOLINA: THANK YOU, MR. SACHS. ON THOSE ITEMS, MOVED BY 

12 RIDLEY-THOMAS, SECONDED BY SUPERVISOR YAROSLAVSKY. IF THERE'S 

13 NO OBJECTION, SO ORDERED ON THOSE ITEMS. 

14

15 ARNOLD SACHS: ITEM 13 IS A QUICK QUESTION REGARDING THIS 

16 CONTRACT. THE CONTRACT IS GOING TO BE INCREASED FROM $239,000 

17 TO $439,000 FOR A TWO-YEAR PERIOD FOR THE COMPUTER EQUIPMENT 

18 DISASTER RECOVERY SERVICES. AND THEN AT THE VERY END, IT 

19 INCLUDES THIS LINE INCREASING THE MAXIMUM CONTRACT SUM IN THE 

20 AMOUNT OF NOT TO EXCEED $100,000 IN THE EVENT DISASTER 

21 RECOVERY SERVICES ARE ACTIVATED OR A DISASTER IS DECLARED. 

22 WELL, WHY WOULD YOU SPEND $100,000 ABOVE AND BEYOND THE 

23 $400,000? ISN'T THAT WHAT THE $400,000 IS TO BE USED FOR, IF A 

24 DISASTER IS DECLARED OR OCCURS? WHAT'S THE $400,000 FOR IF 
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1 YOU'VE GOT TO SPEND AN EXTRA $100,000 TO TURN THE SWITCH ON? 

2 ANOTHER ANSWERED QUESTION. 

3

4 SUP. MOLINA: ITEM 19? 

5

6 ARNOLD SACHS: ITEM 19. THE FINAL BAILOUTS FOR COUNTY U.S.C. 

7 THEY WERE HERE A COUPLE OF MONTHS AGO, SIX MONTHS AGO, MAYBE, 

8 REQUESTING EXTRA FEES AND CHANGE ORDERS. YOU HAVE CHANGE ORDER 

9 1 OF $300,000. CHANGE ORDER 2 OF $217,000. CHANGE ORDER 3, 

10 $426,000. CHANGE ORDER 4, $$27 MILLION. THAT'S A HECK OF A LOT 

11 OF CHANGE ORDERS. WHO'S WATCHING OUT FOR THE PUBLIC'S INTEREST 

12 ON A $27 MILLION TAB FOR CHANGE ORDERS? HOW IS THAT SO EASILY 

13 ACCUMULATED? IT'S MIND BOGGLING. THEY WERE HERE. THEY GOT A 

14 COUPLE OF HUNDRED MILLION DOLLARS THE LAST TIME THEY WERE HERE 

15 FOR CHANGE ORDERS. $27 MILLION. 

16

17 SUP. MOLINA: ITEM 24? 

18

19 ARNOLD SACHS: WELL THANK YOU SO MUCH. ITEM 24. ITEM 24. OH, 

20 SINCE IT'S REGARDING SEISMIC RETROFITTING, AND THERE JUST SO 

21 HAPPENED TO BE A NEWSPAPER ARTICLE IN THE L.A. TIMES, 

22 SUPERVISOR RIDLEY-THOMAS, MAYBE YOU MIGHT HAVE REMEMBERED 

23 THIS, WILL THE COUNTY STAFF BE DEVELOPING A COST ESTIMATE TO 

24 BRING THE M.L.K. FACILITIES UP-TO-DATE ON SEISMIC SAFETY 

25 REQUIREMENTS? BECAUSE EITHER IT'S GOING TO BE DONE BEFORE THE 



December 9, 2008

44

1 HOSPITAL'S OPEN, AND THAT FEE'S GOING TO BE ADDED, OR IT'S 

2 GOING TO BE DONE BY A NEW OWNERSHIP? MAYBE THAT'S THE REASON 

3 WHY THIS WHOLE DISASTER WAS OCCURRING, BECAUSE THE COUNTY'S 

4 BEEN LIKE ABSENTEE LANDLORD SAND SAYING "WELL, WE CAN'T DO 

5 ANYTHING WITH THIS HOSPITAL BECAUSE IT'S GOT TO BE SEISMIC 

6 RETROFIT, WE'LL JUST LET IT GO TO HELL. AND THEN IT WILL BE 

7 SOMEBODY ELSE'S PROBLEM. BUT AS LONG AS THE GOVERNMENT, THE 

8 FEDERAL GOVERNMENT WAS PAYING US $200 MILLION, WE WERE FAT. 

9 IT'S SO RIDICULOUS. 

10

11 SUP. MOLINA: ITEM 25? 

12

13 ARNOLD SACHS: ITEM 25. AND I WANT TO THANK THE COUNTY BOARD OF 

14 SUPERVISORS FOR PUTTING THIS ITEM ON THE AGENDA. THE 

15 METROPOLITAN TRANSPORTATION AUTHORITY. WHEN YOU HAD THE 

16 MEETING ON THURSDAY, THE METROPOLITAN TRANSPORTATION 

17 AUTHORITY, ONE OF THE ITEMS THAT GOT QUITE A LAUGH FROM 

18 EVERYBODY THERE WAS THE CONTRACT THAT WAS BEING DISCUSSED 

19 REGARDING I BELIEVE THE 405 FREEWAY. AND THE MAN MAKING THE 

20 PRESENTATION STATED THAT THE M.T.A. IS PAYING OUT A MILLION 

21 DOLLARS TO THE LOSING BIDDERS. EXCUSE ME? I DIDN'T KNOW THE 

22 M.T.A. WAS FLUSH WITH SO MUCH MONEY THAT THEY COULD BE PAYING 

23 A MILLION DOLLARS OUT TO LOSING BIDDERS. WHAT'S WRONG WITH A 

24 TOTE BAG? WHAT IS GOING ON? THERE'S TALK, THERE'S DISCUSSION. 

25 A MILLION DOLLARS. TO MORE THAN ONE BIDDER. THIS IS M.T.A. 
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1 DOLLARS. M.T.A. DOESN'T HAVE THE FUNDING TO COVER THEIR OWN 

2 EXPENSES. THE REAL PROBLEM? NOT ONE OF THE SUPERVISORS AT THE 

3 MEETING QUESTIONED THIS PROCEDURE. WHY? 

4

5 SUP. MOLINA: THANK YOU, MR. SACHS. 

6

7 ARNOLD SACHS: WHEN YOU HAVE THE OPPORTUNITY TO BRING BACK BUS 

8 SERVICE THAT IS SO POOR THAT IT IMPROVES WHEN IT SUCKS. 

9

10 SUP. MOLINA: THANK YOU, MR. SACHS. 

11

12 ARNOLD SACHS: THANK YOU, MISS MOLINA. 

13

14 SUP. MOLINA: ON ITEM 13, 19, 24 AND 25 MOVED BY SUPERVISOR 

15 ANTONOVICH, SECONDED BY SUPERVISOR RIDLEY-THOMAS. IF THERE'S 

16 NO OBJECTION, SO ORDERED ON THOSE ITEMS. 

17

18 ARNOLD SACHS: WHEN YOU CALL UP, I EXPECT TO BE ABLE TO BE 

19 ALLOWED TO CONTINUE MY -- COMPLETE MY CONVERSATION. YOU CALLED 

20 ME UP ON MULTIPLE ITEMS. I AT LEAST EXPECT TO BE ABLE TO BE 

21 GIVEN THE OPPORTUNITY TO CONTINUE MY CONVERSATION ON ALL OF 

22 THEM. 

23
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1 SUP. MOLINA: THANK YOU, SIR. ALL RIGHT. NEXT WE HAVE, IT'S 

2 JUST FIVE MINUTES EARLY, I WONDER IF THE FOLKS FROM THE HEALTH 

3 SERVICES FOLKS ARE HERE FOR S-1? YES OR NO? TELL ME. 

4

5 SUP. ANTONOVICH: DID WE APPROVE 4? 

6

7 CLERK SACHI HAMAI: YES. 

8

9 SUP. MOLINA: OKAY. THEY'RE COMING UP? AGAIN, THIS IS A SET 

10 ITEM, WHICH IS A REPORT OF L.A. COUNTY U.S.C., THE STATUS 

11 UPDATE. PLEASE JOIN US. HAVE A SEAT. 

12

13 CAROL MEYER: CAROL MEYER, INTERIM DIRECTOR, CHIEF NETWORK 

14 OFFICER, EXCUSE ME. I WANT TO GIVE YOU AN UPDATE. IT'S 

15 INTERESTING. TODAY IS ACTUALLY THE 31ST DAY SINCE THE MOVE TO 

16 THE NEW FACILITY. AND THINGS HAVE ABSOLUTELY IMPROVED AT THE 

17 FACILITY IN TERMS OF PATIENT FLOW. I'D LIKE TO POINT OUT THAT 

18 IN THE ATTACHMENT TO OUR MEMO, WE HAVE THE COMPARISON OF 

19 NOVEMBER TO THE PREVIOUS MONTHS. SO YOU CAN SEE HOW THINGS 

20 IMPROVED OR CHANGED, IN SOME CASES, IN COMPARISON TO BEFORE 

21 THE MOVE. I'D LIKE TO POINT OUT A COUPLE OF KEY INDICATORS. 

22 FIRST OF ALL, THE DIVERSION RATE HAS BEEN AS HIGH AS 80 

23 PERCENT. BUT IN THE LAST WEEK OF NOVEMBER, THE DIVERSION RATE 

24 FOR AMBULANCES TO E.R. SATURATION WENT DOWN TO 33 PERCENT. SO 

25 WE'RE ACTUALLY GOING IN THE RIGHT DIRECTION THERE. THE AVERAGE 
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1 DAILY CENSUS FOR THE MONTH OF NOVEMBER WAS 436, WHICH IS ABOUT 

2 72 PERCENT OCCUPANCY, OR 70 PERCENT OF THE PATIENT FLOW. ON 

3 PAGE 3, AN IMPORTANT FACTOR IS THE BOARDING TIME OF PATIENTS 

4 IN THE EMERGENCY ROOM WAITING FOR A BED INTO THE HOSPITAL. 

5 THAT NUMBER HAS GONE TO ABOUT 4.42, FOUR HOURS AND 42 MINUTES, 

6 WHICH IS HIGHER THAN BEFORE. BUT KEEP IN MIND THAT WE ARE 

7 AVERAGING THE FIRST DAYS IN THE HOSPITAL FOR THAT MONTH WITH 

8 THE LAST DAYS IN THE MONTH. AND WE'RE IMPROVING ON A DAILY 

9 BASIS. ANOTHER IMPORTANT FACTOR IS THE AVERAGE WAITING TIME IN 

10 THE EMERGENCY ROOM. FOR THE ENTIRE MONTH, THE AVERAGE WAITING 

11 TIME IS 10 HOURS, 10-1/2 HOURS APPROXIMATELY. BUT IN THE LAST 

12 FEW DAYS OF NOVEMBER, AND ACTUALLY THIS LAST WEEK, THE WAITING 

13 TIME HAS ACTUALLY GONE DOWN TO 6 TO 8 HOURS. THE LEFT WITHOUT 

14 BEING SEEN HAS UNFORTUNATELY RISEN TO ABOUT 14 PERCENT LEFT 

15 WITHOUT BEING SEEN. AGAIN, AS THE PATIENT FLOW IMPROVES, WE 

16 EXPECT THAT NUMBER TO REDUCE. I'D LIKE TO MAKE A COUPLE OF 

17 OTHER COMMENTS ABOUT THE CENSUS SPECIFICALLY. FOR EXAMPLE, 

18 YESTERDAY, THE CENSUS WAS ACTUALLY 490 AT THE MED CENTER OUT 

19 OF THE 600 BEDS. OF THE MED-SURG PATIENTS, WE ACTUALLY HAD OUT 

20 OF 286 OUT OF 299 GENERAL MED-SURG BEDS FILLED, WHICH IS A 96 

21 PERCENT OCCUPANCY, OR A 94 PERCENT UTILIZATION. WHERE WE ARE 

22 SEEING OUR LACK OF CAPACITY IS IN VERY SPECIALTY UNITS, LIKE 

23 BURN, JAIL, O.B., THE N.I.C.U. AND PEDIATRICS. THOSE BEDS ARE 

24 VERY SPECIFIC FOR VERY SPECIFIC PATIENTS, AND A BED IS NOT A 

25 BED IS NOT A BED IN THOSE PARTICULAR CASES. SO OUR OCCUPANCY 
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1 IS VERY HIGH IN MED-SURG. WE ARE MOVING PATIENTS TO RANCHO LOS 

2 AMIGOS ON A DAILY BASIS. AND WE ARE LOOKING AT THOSE AREAS OF 

3 SPECIALTY TO SEE WHY THOSE ARE UNDER CAPACITY AND WHAT WE CAN 

4 DO TO ACTUALLY BUILD THE CAPACITY THERE. 

5

6 SUP. MOLINA: ANY OTHER QUESTION OR COMMENT? MR. ANTONOVICH. 

7

8 SUP. ANTONOVICH: DETAILS ON THE CENSUS FOR THE TYPES OF 

9 SERVICE, PSYCHIATRY, MEDICAL AND SURGICAL, PEDIATRICS, LABOR 

10 AND DELIVERY. 

11

12 CAROL MEYER: OKAY. 

13

14 SUP. ANTONOVICH: AND THEN HOW IS THE UNIVERSITY OF SOUTHERN 

15 CALIFORNIA DOING ON THE HIRING OF THE PHYSICIANS THAT WE 

16 RECENTLY FUNDED? 

17

18 CAROL MEYER: FROM THE M.S.O.A.? 

19

20 SUP. ANTONOVICH: YES. 

21

22 CAROL MEYER: OKAY, WE CAN DO THAT. 

23

24 SUP. ANTONOVICH: AND THE STATUS OF THEIR HIRING EFFORTS ON 

25 FUTURE REPORTS. HOW'S THE AIR CONDITIONING AT THE HOSPITAL? 
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1

2 CAROL MEYER: AIR CONDITIONING? 

3

4 SUP. ANTONOVICH: IT'S NOT WORKING. 

5

6 CAROL MEYER: I HAVEN'T HEARD THAT IT WASN'T WORKING. 

7

8 SUP. ANTONOVICH: IT WASN'T WORKING THIS PAST WEEK. I HAVE A 

9 FRIEND WHO WAS A PATIENT THERE. SEVENTH FLOOR. 

10

11 DR. JONATHAN FIELDING: WE'LL CHECK THAT OUT, SUPERVISOR. 

12

13 CAROL MEYER: OKAY. WE'LL CHECK OUT THE AIR CONDITIONING. 

14

15 SUP. MOLINA: THEY'RE STILL SORTING OUT LITTLE BUMPS HERE AND 

16 THERE AS THEY GO THROUGH. BUT THEY ARE BASICALLY DOING A VERY 

17 GOOD JOB. AND I APPRECIATE IT. I KNOW THAT YOU ARE GOING TO BE 

18 GRADUATING A CLASS OF NURSES THAT HOPEFULLY WILL BE FULFILLING 

19 MORE OF THE NURSING RESPONSIBILITIES TO MAKE SURE WE CAN OPEN 

20 UP MORE OF THE I.C.U. BEDS. I UNDERSTAND THAT'S IN PROCESS 

21 NOW. AND I APPRECIATE THAT. BUT I DO THINK THAT WE NEED TO 

22 START UTILIZING THE SAME RATE, ONE OR THE OTHER. NOW, IT WAS 

23 SOLD AS A UTILIZATION RATE. SO WE NEED TO UNDERSTAND THAT 

24 CLEARLY BECAUSE -- SO IT WOULD BE EASIER FOR ALL OF US IF WE 

25 ALL STAYED WITHIN THE FRAMEWORK OF REPORTING AS HOPEFULLY WE 
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1 START MINIMIZING DIVERSION AS WE CONTINUE TO REALLY START 

2 FITTING INTO OURSELVES. WE REALLY HAVE TO BE ON THE SAME PAGE. 

3 AND SO IT WAS SOLD AS A UTILIZATION RATE, WHICH IS VERY UNIQUE 

4 AND UNUSUAL. SO UNLESS THERE'S GOING TO BE SOME CHANGE IN THAT 

5 REGARD, I THINK WE ALL HAVE TO GET ON THE SAME PAGE. SO IF 

6 THERE'S GOING TO BE AN OCCUPANCY RATE THAT'S GOING TO BE 

7 UTILIZED, THEN I NEED TO KNOW THAT. BUT CERTAINLY WHEN THEY 

8 CAME HERE AND THEY INSISTED, THE DEPARTMENT INSISTED OVER AND 

9 OVER AGAIN, IT WOULD BE A UTILIZATION RATE, WHICH IS DIFFERENT 

10 FROM OCCUPANCY RATE. SO LET'S STAY WITHIN THE FRAMEWORK OF 

11 WHAT WAS PRESENTED INITIALLY. I THINK THAT WOULD BE HELPFUL TO 

12 ALL OF US. BECAUSE TRYING TO FIGURE OUT -- AND I APPRECIATE 

13 WHAT YOU'RE TALKING ABOUT WHEN IT COMES TO THE MED-SURG BEDS. 

14 I THINK TRYING TO FIGURE OUT HOW WE'RE GOING TO FIT WITHIN THE 

15 FRAMEWORK OF WHAT WE HAVE THERE IS GOING TO BE ESSENTIAL, BUT 

16 ALSO CLEARLY IDENTIFYING WHERE THERE ARE ISSUES WITH 

17 SUFFICIENT TIME IS A BIG PART OF WHAT WE'RE DOING HERE. IS 

18 TRYING TO THINK AHEAD OF TIME AS TO WHAT'S GOING ON. AND OUR 

19 CENSUS AND OUR MOVEMENT OF PATIENTS IS ALL A CRITICAL 

20 COMPONENT OF EVALUATING HOW WE ARE GOING TO FIT WITHIN THE 

21 FRAMEWORK OF WHAT WE HAVE AT L.A. COUNTY U.S.C. BUT I 

22 APPRECIATE YOUR EFFORTS. I APPRECIATE YOUR WORK. AND THANK YOU 

23 SO MUCH FOR YOUR ONGOING REPORTS. WE HAVE DR. CLAVREUL WHO 

24 WISHES TO ADDRESS US ON THIS ITEM. 

25
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1 DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS, 

2 DR. GENEVIEVE CLAVREUL. I APPRECIATE YOU HAVING THE REPORT 

3 PRESENTED BEFORE I SPOKE. I AM CONCERNED MYSELF ABOUT THE 

4 INCREASE OF PEOPLE LEAVING THE EMERGENCY ROOM WITHOUT 

5 TREATMENT. AND I JUST WONDER IF ALL OF A SUDDEN THE WAITING 

6 TIME IS GOING DOWN BECAUSE PEOPLE ARE LEAVING AND NOT SEEING. 

7 THERE HAS BEEN AN INCREASE MONTHLY OF THE PEOPLE LEAVING 

8 WITHOUT RECEIVING CARE. AND THAT'S A VERY DISTURBING TREND 

9 THERE. ALSO, THE GROUP OF NURSES WHO JUST GRADUATED WON'T BE 

10 ABLE TO WORK IMMEDIATELY IN THE HOSPITAL TO PROVIDE CARE. THEY 

11 ARE GOING TO NEED SOME INTERNSHIP AND SO ON. SO THAT'S NOT AN 

12 IMMEDIATE -- 

13

14 SUP. MOLINA: THIS IS AN I.C.U. TRAINING CLASS THAT IS GOING TO 

15 BE GRADUATING. 

16

17 DR. GENEVIEVE CLAVREUL: YEAH. BUT EVEN I.C.U.S, THEY WILL 

18 REQUIRE SOME EXPERTISE, ESPECIALLY WITH THE NEW HOSPITAL, 

19 WHICH HAS A LOT OF NEW EQUIPMENT, WHICH IS WONDERFUL. BUT IT 

20 IS GOING TO TAKE MORE LEARNING PRACTICE TO MAKE IT HAPPEN. 

21 THAT'S ALL I HAVE TO SAY FOR NOW. I APPRECIATE YOU KEEPING A 

22 CLOSE EYE ON WHAT'S GOING ON WITH THIS. 

23

24 SUP. MOLINA: RIGHT. WE ARE TRACKING THOSE NUMBERS AS WE KNOW 

25 THAT THEY'RE A POTENTIAL PROBLEM. BUT VERY GOOD. AND SO THIS 
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1 IS A RECEIVE AND FILE. THERE'S NO OBJECTION, SO ORDERED. DR. 

2 CLAVREUL, SINCE YOU ARE HERE, YOU ALSO HAVE PULLED ITEM NO. 1. 

3

4 DR. GENEVIEVE CLAVREUL: YEAH. 

5

6 SUP. MOLINA: SO WHY DON'T YOU ADDRESS THAT ITEM NOW? 

7

8 SUP. MOLINA: YEAH. IT'S THE SAME ISSUE I HAVE ABOUT THE 

9 APPOINTMENT OF COMMISSIONER FOR THE H.I.V. COMMISSION. THIS 

10 SHOULD BE DONE BY YOU, SUPERVISOR. SO IT SHOULD YOUR APPOINTEE 

11 AND NOT APPOINTED BY THE COMMISSION. AND AS USUAL, IT IS A 

12 PERSON WE APPOINTED NOW IS SOMEBODY WHO IS RECEIVING CARE. AND 

13 I'M SURE IF YOU LOOK AT THE MIX OF THE COMMISSIONERS, THEY 

14 VIOLATE -- IN THE TYPE OF COMMISSIONER YOU SHOULD HAVE TO 

15 DECIDE WHAT'S GOING ON. THANK YOU. 

16

17 SUP. MOLINA: VERY GOOD. ALL RIGHT. ON THAT ITEM, MOVED BY 

18 SUPERVISOR YAROSLAVSKY, SECONDED BY SUPERVISOR ANTONOVICH. 

19 THERE IS NO OBJECTION, SO ORDERED. ON ITEM NO. 1. I'M GOING TO 

20 CALL ON SUPERVISOR RIDLEY-THOMAS FOR HIS SPECIALS? 

21

22 SUP. RIDLEY-THOMAS: THANK YOU, MADAME CHAIR. WITH YOUR 

23 PERMISSION, THERE ARE TWO ADJOURNING MOTIONS. AND THEY ARE AS 

24 FOLLOWS. PRISCILLA MILDRED COLE-PENEGAR, LONG TIME SECOND 

25 DISTRICT RESIDENT, WHO PASSED AWAY ON DECEMBER 2ND, 2008, AT 
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1 THE AGE OF 100 YEARS. SHE RECENTLY CELEBRATED THAT BIRTHDAY ON 

2 NOVEMBER 21. SHE WAS AN ACTIVE COMMUNITY MEMBER AND VOLUNTEER. 

3 SHE LEAVES TO CHERISH HER MEMORY HER NIECES, HER NEPHEWS, 

4 FRANCES HARVEY, LORENZO COLE, JR., JEAN BERRY AND CLARA COLE, 

5 ALONG WITH A HOST OF FAMILY AND FRIENDS WHO WILL REMEMBER HER 

6 FONDLY. SECONDLY, MADAME CHAIR, EMILY BURNS, LONG-TIME SECOND 

7 DISTRICT RESIDENT WHO PASSED ON NOVEMBER 26TH AT THE AGE OF 

8 80. SHE WAS KNOWN AS A COMMUNITY ADVOCATE AND LONG-TIME MEMBER 

9 OF THE NEW MT. CALVARY BAPTIST CHURCH. SHE LEAVES TO CHERISH 

10 HER MEMORY HER HUSBAND, JOHN A. BURNS, JR., HER DAUGHTER, 

11 BARBARA. AND HER BROTHERS, J.L. AND BOB EDWARDS, ALONG WITH, 

12 AGAIN, A HOST OF FAMILIES AND FRIENDS. THAT CONCLUDES MY 

13 ADJOURNING MOTIONS FOR THE TIME BEING, MADAME CHAIR. THANK 

14 YOU. 

15

16 SUP. MOLINA: ALL RIGHT. SO ORDERED ON THOSE ADJOURNMENTS. DO 

17 YOU HAVE ANY OTHER ITEMS? SUPERVISOR YAROSLAVSKY? 

18

19 SUP. YAROSLAVSKY: YES. I HAVE ONE ADJOURNING MOTION, MADAME 

20 CHAIR. AS WE ADJOURN IN MEMORY OF JEREMY EISENSTEIN, A 

21 RESIDENT OF MY DISTRICT IN THE WEST SAN FERNANDO VALLEY WHO 

22 SUDDENLY PASSED AWAY AT THE UNTIMELY AGE OF 44. HE HAD BEEN 

23 ONE OF OUR SPECIAL CALABASAS AND WOODLAND HILLS-TARZANA 

24 CHAMBER MEMBERS IN 1996, SUMMA CUM LAUDE GRADUATE FROM THE 

25 CLEVELAND CHIROPRACTIC COLLEGE IN LOS ANGELES. HE SERVED AS 
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1 CLASS VALEDICTORIAN, AND SOON AFTER, EMBARKED ON HIS CAREER IN 

2 CHIROPRACTIC MEDICINE. HE WAS KNOWN AND LOVED AS A CARING, 

3 COMPASSIONATE PRACTITIONER, WHO ALWAYS LET HIS PATIENTS KNOW 

4 THAT THEIR HEALTH AND COMFORT WAS HIS TOP PRIORITY. HE WAS 

5 ALSO A MEMBER OF THE CALABASAS CHAPTER OF KIWANIS 

6 INTERNATIONAL AND THE CALIFORNIA CHIROPRACTIC ASSOCIATION. HE 

7 IS SURVIVED BY HIS WIFE, CAROLYN, AND HIS SON, CHRISTOPHER. 

8

9 SUP. MOLINA: SO ORDERED ON THOSE ADJOURNMENTS. I ALSO WANTED 

10 TO JOIN WITH MY COLLEAGUES ON THE ADJOURNMENT FOR BEATRIZ 

11 VALDEZ. I WAS ALWAYS IMPRESSED THAT OF HER OWN PERSONAL STORY 

12 THAT SHE STARTED OUT AS A STENOGRAPHER HERE IN L.A. COUNTY AS 

13 A YOUNG WOMAN AND ROSE FROM THE RANKS WITH THE SECRETARIAL 

14 ADMINISTRATIVE RESPONSIBILITIES TO BECOME OUR DEPARTMENT HEAD 

15 AS A REGISTRAR-RECORDER. SHE IS SOMEONE THAT I KNEW 

16 PERSONALLY. SHE WAS A VERY DEDICATED PUBLIC SERVANT. AND I 

17 PERSONALLY WANT TO EXTEND OUR DEEPEST CONDOLENCES TO HER 

18 SISTER AND ALL OF HER FAMILY MEMBERS. AND ALSO I'D LIKE TO ASK 

19 THAT WE JOIN -- THAT WE ADJOURN TODAY IN THE MEMORY OF FIRST 

20 DISTRICT CONSTITUENT, SCOTT RUFFALO, WHO TRAGICALLY PASSED 

21 AWAY. HE IS THE BROTHER OF MARK RUFFALO, HE IS ALSO MY 

22 ADMINISTRATIVE ASSISTANT, SANDRA FIERO'S FAMILY MEMBER. SO WE 

23 WANT TO EXTEND HEARTFELT CONDOLENCES TO THE ENTIRE FAMILY. I 

24 THINK THAT CONCLUDES ALL OF OUR ITEMS ON THE AGENDA. AND NOW 

25 WE MOVE ON TO PUBLIC COMMENT. MR. SACHS, DO YOU WANT TO COME 
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1 UP AND JOIN US? AND ROSALIE MARKS HANFT, IF YOU'LL PLEASE JOIN 

2 US? 

3

4 SUP. YAROSLAVSKY: MADAME CHAIR, WHILE THEY'RE COMING UP, IF I 

5 COULD JUST MAKE AN ANNOUNCEMENT. I HAVE JUST BEEN ADVISED THAT 

6 WE HAVE A RED FLAG WARNING AT LEAST IN THE SANTA MONICA 

7 MOUNTAINS IN THE WESTERN PART OF THE COUNTY. I WOULD IMAGINE 

8 IT ALSO APPLIES TO OTHER PARTS OF THE COUNTY THAT IS IN EFFECT 

9 THROUGH 4 P.M. WEDNESDAY, 4 P.M. TOMORROW, WEDNESDAY. MY STAFF 

10 TELLS ME IT IS BLOWING UP QUITE A STORM OUT THERE. SO IF WE 

11 CAN GET THE WORD OUT TO OUR CITIZENRY TO BE VIGILANT IN THE 

12 NEXT 36 HOURS, THAT WOULD BE HELPFUL. THANK YOU. 

13

14 SUP. MOLINA: THANK YOU FOR THE INFORMATION UPDATE ON THAT. ALL 

15 RIGHT. MR. SACHS? 

16

17 ARNOLD SACHS: THANK YOU. AGAIN, ANOTHER FINE TIME TO ADDRESS 

18 SOME PROBLEMS WITH THE L.A.C. M.T.A. AND THE NEW MEASURE R 

19 THAT WAS PASSED, AND THE FACT THAT SINCE SUP. THOMAS, YOU 

20 WEREN'T AT THE MEETING, I THOUGHT I MIGHT BRING TO YOUR 

21 ATTENTION, OR MAYBE YOU MIGHT BE ABLE TO ADDRESS THIS, SINCE 

22 YOU'RE COMING FROM THE STATE LEGISLATION. THAT STATE BILL 314, 

23 AUTHORED BY STATE SENATOR MURRAY, IN 2003 WAS CREATED -- GAVE 

24 AUTHORITY TO METRO TO PLACE A HALF CENT SALES TAX ON THE 

25 BALLOT WITH SPECIFIED CONDITIONS. THE NEW MEASURE R THAT WAS 
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1 JUST PASSED, THE -- MEASURE R, MODIFIES THIS HALF CENT SALES 

2 TAX. BUT IN THE MEANTIME, THE POINT THAT I'M MAKING HERE IS 

3 THAT THERE WERE 19 PROJECTS AUTHORIZED UNDER THE MURRAY BILL. 

4 THE TRANSIT COALITION AND THE L.A. D.O.T. BOTH SUPPORT MEASURE 

5 R. THE TRANSIT COALITION, THEY LIST 20 PROJECTS. 16 OF THE 20 

6 PROJECTS WOULD HAVE BEEN AUTHORIZED UNDER THE MURRAY BILL. AND 

7 THE L.A. D.O.T., THEY LIST 11 PROJECTS TO BE FUNDED UNDER 

8 MEASURE R. SEVEN MUCH THOSE 11 PROJECTS WOULD HAVE BEEN FUNDED 

9 UNDER THE MURRAY BILL THAT WOULD HAVE PASSED IN 2003. NO 

10 ACTION WAS TAKEN. STATE LEGISLATION PASSED IT. NOBODY KNOWS 

11 WHAT'S HAPPENED IN THE COUNTY BOARD OF SUPERVISORS. THE MAYOR 

12 COMES IN WITH A BACK DOOR PLAN. MEASURE R IS IN FRONT OF US. 

13 ISN'T THAT WONDERFUL? THE QUESTION IS: THERE'S A COUPLE OF 

14 QUESTIONS. BUT WHY WAS NO ACTION TAKEN ON MEASURE R? EXCUSE ME 

15 ON THE STATE BILL 314? MAYBE IT'S BECAUSE IT HAD A TIME LIMIT. 

16 THAT BEING SAID, THE M.T.A. IS GOING TO TAKE CREDIT FOR ITEMS 

17 THAT WOULD HAVE BEEN ENACTED IN 2003 OR 2004 AT THE LATEST IF 

18 THE HALF CENT SALES TAX HAD BEEN ON THE AGENDA. THE 2008 LONG-

19 RANGE PLAN THAT WAS PROPOSED BY THE M.T.A. AND WAS HELD DUE TO 

20 THE OUTCOME OF MEASURE R, MEASURE R PASSED. THE 2008 LONG-

21 RANGE PLAN WASN'T CONSIDERED IN THE LAST MEETING. ANY IDEA 

22 WHEN THAT MIGHT APPEAR BEFORE THE M.T.A. BOARD? MAYBE NEXT -- 

23 WELL THERE IS NO MEETING IN DECEMBER. SO MAYBE IN JANUARY? 

24 MAYBE IT WILL APPEAR THEN? MAYBE YOU WILL ACT ON IT THEN? 

25 MAYBE YOU WILL ACT ON SOMETHING? REMEMBER, THESE ARE PUBLIC 
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1 DOLLARS, NOT METRO DOLLARS. PUBLIC DOLLARS. PAY ATTENTION. 

2 THANK YOU. 

3

4 ROSALIE M. HANFT: THANK YOU SO VERY MUCH. I'M GRATEFUL FOR THE 

5 OPPORTUNITY TO BE AMONG THE MOST POWERFUL, CAPABLE PEOPLE, THE 

6 BOARD OF SUPERVISORS, AND PLEAD FOR HELP. I'M ASKING FOR 

7 FOLLOW UP BECAUSE I WAS HERE LAST WEEK, AND SUPERVISOR KNABE 

8 SAID THAT I COULD COME UP FOR FOLLOW UP. AND I DID BRING THE 

9 PAPERS DOWN TO THE OFFICE OF MARK SALADINO, THE TREASURER AND 

10 TAX COLLECTOR. AND THERE'S NO FOLLOW UP. AND I'D LIKE TO SPEAK 

11 TO SOMEBODY WHO IS CAPABLE OR COULD HELP ME. PLEASE. I DON'T 

12 WANT TO HAVE TO GIVE IT TO AN ATTORNEY. THESE PAPERS PROVE HOW 

13 TERRIBLY WRONG THE AUDITOR-CONTROLLER IS. IT'S BLATANTLY 

14 EVIDENT. ANYBODY HAS TO BE BRAIN DEAD NOT TO KNOW IT. 

15

16 SUP. MOLINA: OKAY. ALL I CAN SAY IS THE LETTER OF OCTOBER THE 

17 29TH THAT WAS SENT TO YOU CLEARLY STATES THE SITUATION. WE 

18 APOLOGIZE FOR THE INITIAL MIXUP. BUT IT HAS BEEN ALL 

19 CORRECTED. AND SO, AGAIN, IT IS YOUR DECISION IF YOU WANT TO 

20 PURSUE A LAWYER. I DON'T KNOW. WE CAN CONTINUE TO TALK TO YOU, 

21 BUT THE LETTER VERY CLEARLY STATES THE CORRECTIONS AND ALL OF 

22 THE ISSUES. 

23

24 ROSALIE M. HANFT: BUT THE LETTER IS TOTALLY CORRUPT. IT'S A 

25 BIASED LETTER. IT'S FROM THE PEOPLE THAT MADE THE MISTAKES. 
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1 IT'S JUST LIKE THE HOSPITAL, MARTIN LUTHER KING, WHERE THEY 

2 KILL PEOPLE. AND BECAUSE PEOPLE ARE INCOMPETENT. THEY HAVE NO 

3 RIGHT TO KILL THE PEOPLE AND TO BE THERE. THIS IS NOT FAIR 

4 THEY SHOULD TAKE ADVANTAGE OF INNOCENT PEOPLE. SO THE ONLY 

5 THING THAT HAS TO BE DONE IS GIVE IT TO AN ATTORNEY TO GET 

6 JUSTICE. AND YOU HAVE TO FIND AN ATTORNEY, WHICH THERE ARE 

7 PLENTY OF ATTORNEYS, WHO ARE NOT AFRAID OF THE GOVERNMENT AND 

8 ARE NOT LOOKING TO BE PROTECTED FROM THE GOVERNMENT. THANK 

9 YOU. THAT LETTER IS TOTALLY CORRUPT AND IT'S ADDING INJURY TO 

10 INJURY. TOTALLY DISGUSTING AND REPUGNANT. WRITTEN BY THE 

11 PEOPLE WHO DID ALL THIS SCAM. WHERE COULD YOU GO IF THE 

12 GOVERNMENT IS CORRUPT? THERE'S NO PLACE TO GO. SO THANK YOU 

13 VERY MUCH. 

14

15 SUP. MOLINA: THANK YOU. ALL RIGHT. THERE ARE NO OTHER ITEMS 

16 COMING BEFORE US. WE STAND ADJOURNED. AND WE WILL BE GOING 

17 INTO CLOSED SESSION. OR WE SHOULD NOT ADJOURN, BECAUSE WE 

18 HAVEN'T GONE INTO CLOSED SESSION AS OF YET. THANK YOU SO VERY 

19 MUCH. 

20

21 CLERK SACHI HAMAI: IN ACCORDANCE OF BROWN ACT REQUIREMENTS, 

22 NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL 

23 CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. CS-1, CONFERENCE 

24 WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION, AS INDICATED 

25 ON THE SUPPLEMENTAL AGENDA. THANK YOU. 
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